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ВВЕДЕНИЕ 

 

Процессы обработки металлов давлением (ОМД) находят широ-

кое применение во многих отраслях промышленности: машинострое-

нии, авиастроении, вагоностроении, судостроении и др. К примеру, 

автомобиль на 80-85 % состоит из деталей полученных методами об-

работки металлов давлением. 

К процессам обработки металлов давлением относят процессы 

горячей и холодной штамповки, осадки, ковки, прокатки, вытяжки, 

прошивки, гибки и многие другие. К отдельным методам обработки 

металлов давлением можно отнести процессы изготовления гнутых 

профилей получаемых на гибочно-прокатных станах. 

Несмотря на широкое применение методов ОМД сами процессы 

еще недостаточно изучены, что сдерживает разработку оптимальных 

технологий, позволяющих оптимизировать технологический процесс 

изготовления деталей и снизить расходы для их производства. В 

первую очередь, это связано со сложностью процессов, происходя-

щих при пластическом течении металла при обработке металлов дав-

лением. Исследованию пластического течения посвящено немало 

научной литературы, где выводятся расчетные формулы для различ-

ных процессов ОМД. К сожалению, теоретические формулы можно 

вывести только для относительно простых процессов и со значитель-

ными допущениями, например, к процессам гибки, вытяжки, осадки и 

к заготовкам простой формы: цилиндр, круглой формы, плоского 

квадратного листа. При применении заготовок более сложной формы 

и применению более совершенных методов ОМД такие формулы уже 

не работают или дают значительную погрешность и не могут приме-

няться при разработке оптимальных технологий. Применяемые в тео-

рии ОМД различные приближенные методы сложны в освоении и 

требуют тщательного подхода при их применении. 

Выходом из этой ситуации является применение программ ос-

нованных на методе конечных элементах. Наилучшая в своей области 
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–  это программа ANSYS/LS-DYNA. Программа предназначена для 

расчетов быстротекущих и динамичных задач физики и процессов, 

имеющих значительную нелинейность, и идеально подходит для ре-

шения задач обработки металлов давлением, поскольку процессы 

пластической деформации в процессах ОМД обладает большой нели-

нейностью и быстротечны. 

ANSYS/LS-DYNA позволяет моделировать практически все 

процессы обработки металлов давлением, начиная от простой гибки 

или осадки заготовки, заканчивая деформацией многослойных мате-

риалов или штамповкой взрывом. При этом в отличие от теоретиче-

ских расчетов, где есть существенные ограничения по размерам и 

форме заготовки, здесь практически нет ограничений по размерам и 

формам заготовок. Связано это с тем, что при построении конечно-

элементной модели происходит разбиение заготовки любой сложно-

сти на элементарные ячейки (треугольники, четырехугольники, пира-

миды и др.). Таким образом, значительно расширяя области примене-

нии этой программы. 

Моделирование процессов ОМД в программе ANSYS/LS-DYNA 

позволяет определить все необходимые параметры: напряженно-

деформированное состояние заготовки и инструмента в любой точке 

и в любой момент времени, а также энергетические параметры про-

цесса, величины усилий и моментов, нормальных и касательных сил, 

контактные параметры процесса и много другое, что необходимо при 

разработке оптимального технологического процесса и для глубокого 

анализа и понимания процессов, происходящих в заготовке при пла-

стическом течении материала. 

Основные сложности моделирования в программе ANSYS/LS-

DYNA это наличие большого количества разнообразных меню и па-

раметров, требующих ввода, что требует высокой подготовки и глу-

бокого понимания процесса и необходимость высокопроизводитель-

ных систем для их решения. 
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ГЛАВА 1 

 

ПОДХОДЫ К МАТЕМАТИЧЕСКОМУ МОДЕЛИРОВАНИЮ 

ПРОЦЕССОВ ОМД 

 

1.1. Общий обзор 

 

Математическое моделирование является эффективным сред-

ством анализа и понимая различных объектов нашего мира. 

Математическое моделирование является наиболее совершен-

ным и эффективным методом моделирования, открывая путь для 

применения современных мощных методов математического анализа, 

вычислительной математики и программирования при исследовании 

и оптимизации технологических процессов. В настоящее время коли-

чественные методы исследования проникают практически во все сфе-

ры человеческой деятельности, а математические модели становятся 

средством познания основных закономерностей реального мира. 

Большой вклад в развитие методов математического моделирования 

процессов обработки металлов давлением внесли отечественные и за-

рубежные учѐные - В. Джонсон, Э. Томсен, Р. Хилл, А.И. Целиков, 

П.И. Полухин, И.Я. Тарновский, Г.Я. Гун, А.А. Поздеев, В.П. Полу-

хин, А.П. Чекмарев, В.П. Северденко, Г.А. Смирнов-Аляев, В.С. 

Смирнов, И.Л. Перлин, А.Д. Томленов, Б.В. Кучеряев и др. Анализу 

современных подходов к моделированию процессов обработки ме-

таллов давлением посвящены работы Г.Я. Гуна, А.П. Грудева, Б.В. 

Кучеряева, С.Е. Рокотяна, А.В. Выдрина и многих других [1]. 

Начало 80-х годов XX века можно считать временем первого 

внедрения компьютерного моделирования процессов ОМД в про-

мышленность. Тогда несколько машиностроительных компаний США 

начали использовать программный пакет ALPID (Analysis of Large 

Plastic Incremental Deformation), разработанный Баттельским мемори-

альным институтом при содействии ВВС США. Этот программный 

продукт имел множество технических проблем, например, таких как 
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малая функциональность препроцессора и большие временные затра-

ты на моделирование штамповки поковок даже простой формы. В 

частности, моделирование процесса штамповки диска турбины про-

стейшей формы занимало несколько дней. Кроме того, в этот период 

пользователю приходилось несколько раз останавливать моделирова-

ние, чтобы внести некоторые необходимые поправки в исходные дан-

ные. Пакет ALPID позволял решать лишь двумерные задачи (2D), а 

именно — моделировать течение металла при штамповке осесиммет-

ричных деталей. Трехмерное моделирование в то время казалось не-

возможным вследствие соответствующего уровня развития вычисли-

тельной техники, сложностей с генерацией сетки конечных элементов 

и т.п. Несмотря на все эти проблемы, ALPID показал весьма достой-

ные результаты, позволяющие предприятиям-пользователям значи-

тельно экономить средства, необходимые для проведения экспери-

ментальных исследований при разработке новых технологических 

процессов. Шаг за шагом моделирование процессов ОМД стало важ-

ным элементом разработки технологического процесса. Сегодня бо-

лее 80% крупных (250 и более сотрудников), более 75% средних (100-

249 сотрудников) и более 50% мелких (50-99 сотрудников) машино-

строительных компаний США используют моделирование процессов 

ОМД при разработке технологических процессов [2]. 

Современная форма математического моделирования - это мо-

делирование на компьютере. Вычислительные машины дали учѐным 

мощное средство для математического моделирования. Развитие ме-

тодов математического моделирования и оптимизации процессов об-

работки металлов давлением в сочетании с широким внедрением пер-

сональных компьютеров позволяют создавать уникальные програм-

мы, позволяющие в автоматизированном режиме моделировать про-

цессы пластического формоизменения, исследовать напряжѐнно-

деформированное состояние, температурные поля при обработке ме-

таллов давлением [3]. 

Исследования, проводимые в программах конечно-элементного 

моделирования, позволяют подобрать оптимальный технологический 



 

 10 

процесс при обработке металлов давлением, оптимальные, рацио-

нальные марки материала в зависимости от напряженно-

деформированного состояния конструкции, рациональные материалы 

и форму для максимальной эффективности удара при разрушении и 

др. 

Результаты моделирования позволяются выявить напряженно-

деформированное состояние, как самой конструкции, так и формую-

щего элемента в любой точке модели и любой промежуток времени; 

критические, опасные зоны и участки модели, в которых возможно 

возникновения разрушения или деформации конструкции; силовые, 

энергетические, деформационные, контактные величины при взаимо-

действии частей модели и многое другое. 

Внедрение компьютерного моделирования в производство со-

провождалось серьезными изменениями в подходе к разработке тех-

нологических процессов. Двадцать пять лет назад очень немногие 

технологи пользовались такими понятиями, как напряжение текуче-

сти, интенсивность деформаций, интенсивность скоростей деформа-

ций. При моделировании процессов ОМД эти показатели весьма су-

щественны. На данный момент вузы и промышленные предприятия 

осознали важность моделирования процессов ОМД при разработке 

технологических процессов и в связи с этим уделяют данному вопро-

су все больше внимания. Моделирование процессов ОМД в вузах ча-

сто выделяется в отдельную дисциплину. Во-первых, это позволяет 

студентам лучше освоить теорию обработки металлов давлением — 

не только по рисункам и диаграммам из справочников, но и на основе 

расчетов и анализа результатов. Во-вторых, проведение лабораторных 

работ помогает студентам лучше понять специфику каждого техноло-

гического процесса обработки металлов, изучить его особенности и 

проблемы. В третьих, работа на компьютере для современных студен-

тов намного привлекательнее работы в читальном зале библиотеки 

[2].  
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1.2. Основы теории явного метода динамики 

 

Явными (Explicit) методами называют методы решения уравне-

ний динамики, не связанные с решением систем уравнений, но исполь-

зующие рекуррентные соотношения, которые выражают перемещения, 

скорости и ускорения на данном шаге через их значения на предше-

ствующих шагах. В случае использования диагональной матрицы масс 

(вместо стандартной – согласованной разряженной) удается ее ―обра-

тить‖, упростив тем самым расчет и многократно уменьшив время од-

ной итерации (посредством замены триангуляции матриц с решениями 

при переменных уравновешивающих нагрузках на матричные умно-

жения). Такая методика предполагает малые шаги и достаточно мел-

кую разбивку, чтобы правильно описать диагональной матрице рас-

пределения масс. В качестве компенсации, малый шаг позволяет от-

следить все изменения в характеристиках конструкции и в ее поведе-

нии. Все нелинейности (включая контакт) учитываются в векторе 

внутренних сил. Основное время занимает не формирование и обра-

щение матриц, а вычисление этого вектора. Из-за очень малого разме-

ра шага (на практике 10
-7

 – 10
-6

) явные методы обычно применяются 

только для расчета кратковременных процессов. В ANSYS/LS-DYNA 

при явном интегрировании применяется метод центральных разностей, 

когда ускорение полагается постоянным в течение шага. Для трех по-

следовательных моментов времени принимается квадратичная аппрок-

симация вектора перемещений [4].  

При использовании явного метода решения применяется метод 

центральных разностей [5] – это ускорение, оцененное за время t: 

      int1

t

ext

tt FFMa 


; 

где ta  - вектор ускорения; 

       
ext

tF  - приложение внешней силы; 

       
int

tF  - внутренние силы; 

  
conthg

n

T

t FFdBF 













 



int
; 
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  где 
hgF  - сила сопротивления искажению hourglass; 

        
contF  - контактная сила. 

Исходя из полученных значений ускорений ( ta ) вычисляются 

скорости и перемещения: 

      tttttt taVV   2/2/ ;       2/2/ ttttttt tVUU   ; 

где  tttt tt   t2/ t5,0 ; 

         tttt tt   t2/ t5,0 ; 

Геометрия обновляется добавлением приращения перемещения 

и исходной геометрии  0x : 

     tttt uxx   0  

Некоторые замечания: 

- для упрощения обращения матриц требуется диагональная 

матрица масс; 

- уравнения становятся разъединенными и могут быть решены 

явно; 

- не требуется обращение матрицы жесткости, все нелинейности 

(включая контакт) включены в вектор внутренних сил; 

- не требуется проверка сходимости, т.к. уравнения несвязанны; 

- для устойчивости решения требуются очень малые временные 

шаги. 

Решение будет устойчиво, только если временной шаг (такт) 

меньше критического: 

max

2


 crittt ; 

где max - максимальная собственная круговая частота. 

Поскольку этот шаг очень мал, то явный метод применяется 

только для очень быстрых процессов. 

Критический шаг для участка длиной L будет равен: 

c

L
 critt ; 
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где с – скорость прохождения звука для используемого матери-

ала. 

Для увеличения стабильности процесса используют по умолча-

нию масштабный коэффициент 0,9: 

c

L
9,0 critt . 

Для конечных элементов величина L зависит от длины конечно-

го элемента: 

  для оболоченных элементов: 
 4321 ,,,max LLLL

А
L  ; 

для треугольных оболоченных элементов: 

 321 ,,max

2

LLL

А
L  . 

 

1.3. Программное обеспечение для математического моделиро-

вания процессов ОМД 

 

Рассмотрим  аналоги программного обеспечения для математи-

ческого моделирования процессов ОМД, их краткое описание. Это та-

кие пакеты как MSC Nastran, Marc, Dytran, PAM-STAMP 2G, 

QForm 3D, ANSYS [6] (табл. 1.1). 

ANSYS/LS-DYNA - многоцелевая программа, использующая 

явную постановку метода конечных элементов (explicit finite element 

program) - предназначена для анализа нелинейного динамического от-

клика трехмерных неупругих структур. Полностью автоматизирован-

ный процесс решения контактных задач, а также множество функций 

по проверке получаемого решения позволяют инженерам успешно 

решать сложнейшие задачи удара, разрушения и формования (про-

цессов ОМД). 

Рассмотренные программы можно разделить на универсальные 

и специализированные. Универсальные позволяют решать более ши-

рокий круг задач, более гибки к нестандартным и сложным задачам. 

Однако, такие программы сложны в обучении, требуют наличия спе- 
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Таблица 1.1 

Программы конечно-элементного моделирования и их краткое 

описание 
 

Назначение 

П
р
и

м
. 
в
 О

М
Д

*
 

У
н

и
в
ер

са
л
ь
н

ая
/ 

сп
ец

и
л
и

зи
р
о

в
. 

1 2 3 

MSC Nastran 

Обеспечивает полный набор расчетов, включая рас-

чет напряженно-деформированного состояния, запасов 

прочности, собственных частот и форм колебаний, ана-

лиз устойчивости, исследование установившихся и не-

установившихся динамических процессов, решение за-

дач теплопередачи, акустических явлений, нелинейных 

статических и нелинейных переходных процессов, ана-

лиз сложного контактного взаимодействия, расчет кри-

тических частот и вибраций роторных машин, анализ 

частотных характеристик при воздействии случайных 

нагрузок и импульсного широкополосного воздействия, 

исследование аэроупругости на дозвуковых и сверхзву-

ковых скоростях. 

4 

У
н

и
в
ер

са
л
ь
н

ая
 

Marc 

Представляет собой универсальную конечно-

элементную программу для проведения углубленного 

анализа высоконелинейного поведения конструкций и 

решения задач теплопередачи. Она широко используется 

для компьютерного моделирования технологических 

процессов прокатки, прессования, листового и объемно-

го формования, производства шин, суперпластического 

формования и т.д. 

5 

У
н

и
в
ер

са
л
ь
н

ая
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Продолжение таблицы 1.1 

1 2 3 

Dytran 

Система анализа высоконелинейных быстротекущих 

процессов, связанных с взаимодействием конструкции и 

жидкости (газа) или конструкции и конструкции. Про-

грамма позволяет решать широкий спектр задач, связан-

ных с быстротекущими процессами (моделирование 

столкновения конструкций, разрушения лопатки и т.д.). 

Dytran применяется в автомобильной, аэрокосмической, 

оборонной, обрабатывающей и многих других отраслях 

промышленности. 

4 

С
п

ец
и

ал
и

зи
р
. 

PAM-STAMP 2G 

Специализированное, интегрированное и масшта-

бируемое решение для листовой штамповки. Оно моде-

лирует весь процесс изготовления оснастки от проекти-

рования рабочей поверхности штампа до анализа фор-

мообразующих характеристик с проверкой правильности 

решения, включая анализ и компенсацию пружинения. 

PAM-STAMP 2G — специально-ориентированное сред-

ство разработки и анализа для проектных организаций, 

КБ и предприятий Автомобильной и Аэрокосмической 

промышленности. 

5 

С
п

ец
и

ал
и

зи
р
. 

QForm 3D 

Основана на методе конечных элементов (ядро си-

стемы), предназначена для проектирования оснастки, 

штампового инструмента, моделирования штамповки, 

ковки и других процессов ОМД, оптимизации техноло-

гических процессов. Конечно-элементные алгоритмы 

специальным образом адаптированы для расчета про-

цессов формоизменения. 

5 

С
п

ец
и

ал
и

зи
р
. 
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Продолжение таблицы 1.1 

1 2 3 

DEFORM   

Специализированный инженерный программный 

комплекс, предназначенный для анализа процессов об-

работки металлов давлением, термической и механиче-

ской обработки, позволяет моделировать практически 

все процессы, применяемые в обработке металлов дав-

лением (ковка, штамповка, прокатка, прессование и др.), 

а также операции термической обработки (закалка, ста-

рение, отпуск и др.) и механообработки (фрезерование, 

сверление и др.). 

5 

С
п

ец
и

ал
и

зи
р
. 

ANSYS 

Универсальная программная система конечно-

элементного анализа, существующая и развивающаяся 

на протяжении последних 30 лет. Является довольно по-

пулярной у специалистов в области компьютерного ин-

жиниринга (CAE, Computer-Aided Engineering) и КЭ ре-

шения линейных и нелинейных, стационарных и неста-

ционарных пространственных задач механики деформи-

руемого твѐрдого тела и механики конструкций (включая 

нестационарные геометрически и физически нелиней-

ные задачи контактного взаимодействия элементов кон-

струкций), задач механики жидкости и газа, теплопере-

дачи и теплообмена, электродинамики, акустики, а также 

механики связанных полей. 

5 

У
н

и
в
ер

са
л
ь
н

ая
 

* - оценка по 5-и бальной системе 

 

специальных знаний в области исследуемых задач и основ конечно-

элементного моделирования. Подходят для исследовательских и 

научных организаций, для глубокого анализа исследуемых процессов. 

Специализированные направлены на определенный класс задач, про-

сты в обучении и не требуют глубокого знания процесса и отдельных 
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дополнительных знаний, отличных от исследуемого процесса. Однако 

такие программы не обладают достаточной гибкостью и позволяют 

решать лишь определенный узкий класс задач. Специализированные 

программы подходят для технологических отделов производственных 

организаций занимающихся конкретным классом задач. 

Для исследования процессов ОМД и разработки данных мето-

дических материалов использовалась программа ANSYS/LS-DYNA, 

позволяющая исследовать практически любой из процессов обработ-

ки давлением. 

 

1.4. Описание программы ANSYS/LS-DYNA 

   

Пакет ANSYS/LS-DYNA объединяет в себе расчетный модуль 

LS-DYNA со средствами подготовки исходных данных и обработки 

результатов в пакете ANSYS. Соответственно, не выходя из сессии 

ANSYS, можно создавать конечно-элементную модель в препроцессо-

ре ANSYS, получать решение по явной схеме интегрирования, ис-

пользуя LS-DYNA, и просматривать результаты с помощью стандарт-

ных постпроцессоров ANSYS [4]. 

Стандартная конфигурация ANSYS и пакет ANSYS/LS-DYNA 

дополняют друг друга. В ANSYS поддерживаются неявные (implicit) 

методы интегрирования динамики, использующие схему Ньюмарка. 

Расчет сводится к серии решений квазистатических задач с нагрузка-

ми, зависящими от времени. Временной шаг может быть не очень ма-

лым, поскольку при каждом шаге выполняется решение системы урав-

нений и проводятся уравновешивающие итерации, связанные с мат-

ричными операциями. При линейной матрице жесткости интегрирова-

ние является, безусловно, устойчивым. Для высокоскоростных процес-

сов (протекающих обычно несколько миллисекунд) и при очень боль-

ших деформациях приходится делать шаги весьма малыми, чтобы от-

следить изменение нагрузки и поведение конструкции. Инерционные 

нагрузки велики и определяются ускорениями конструкции. Для более 

точного их расчета эффективно будет вводить ускорения (и скорости) 
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в число узловых степеней свободы и вычислять из напрямую, а не 

дважды, деференцируя перемещения. В случае вынужденных постоян-

ных пересчетов матриц формирование полной матрицы и ее много-

кратное решение при переменных нагружениях неэффективны. Крите-

рий сходимости установленные по умолчанию, настроены на доста-

точно длительные задачи, поэтому их подбор на практике весьма тру-

доемок (а порой невозможен). Таким образом, при малом шаге реше-

ния задач (например, удара) может потребовать больше (в десятки-

сотни раз) времени ЭВМ, чем при использовании явных методов, либо 

не сойтись [4].  

В отличие от ANSYS расчетный модуль LS-DYNA использует 

явную постановку решения задачи и позволяет успешно решать крат-

ковременные и быстротекучие задачи, такие как удары, столкновения 

и задачи обработки металлов давлением. 

Особенности ANSYS/LS-DYNA[4]: 

 В программе ANSYS/LS-DYNA не очень много типов элементов, 

но для каждого из них имеется выбор множества формулировок, 

и почти все они поддерживают практически все разрешенные 

модели материалов; 

 Хотя препроцессор ANSYS поддерживает далеко не все из более 

чем 230 моделей материалов LS-DYNA, их можно ввести «вруч-

ную», отредактировав файл *.k. Следует отметить, что поставля-

емый модуль позволяет решать все задачи, не поддерживаемый 

ANSYS/LS-DYNA. Пользователям представляется полная версия 

LS-DYNA (с моделями подушек и ремней безопасности, взрыв-

чатки и т.п., сложными моделями материалов). 

 В отличие от ANSYS Implicit очень многие модели материалов 

поддерживают разрушение. 

 Наряду с привычными компонентами, многие команды подразу-

мевают ввод частей (Part) — групп элементов, имеющих одина-

ковые атрибуты: тип элементов, номер материала и номер набора 

действующих постоянных. Группы Part создаются автоматически 

после ввода элементов. 
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 Решение контактных задач в ANSYS/LS-DYNA организовано 

удобнее, чем в обычном ANSYS. Существует множество кон-

тактных алгоритмов, вместо специальных контактных элементов 

назначаются контактные пары (возможен и автоматический по-

иск контактирующих пар). Значения параметров, принятые по 

умолчанию, как правило, обеспечивают хорошую сходимость. 

 Применение концепции жестких тел (Rigid Body) для тел, напря-

женное состояние которых в данный момент времени неактуаль-

но (например, при падении вплоть до момента контакта, либо ин-

струмента в процессах ОМД), позволяет значительно экономить 

машинные ресурсы. При этом тела в процессе расчета могут пе-

реводиться из жестких в деформируемые и обратно. 

 Нагрузки всегда вводятся массивами по времени и соответствуют 

одному шагу нагружения. 

 Расчеты ANSYS/LS-DYNA можно проводить и в стандартной ла-

гранжевой постановке, и в комбинированной лагранж-эйлеровой 

(Arbitrary Lagrange-Euler) постановке. В LS-DYNA поддержива-

ется и полная эйлерова постановка, для которой следует допол-

нить файл, подготовленный препроцессором ANSYS. Лагранже-

вая постановка подразумевает деформируемую сетку, а при эй-

леровой — сетка неподвижна и должна создаваться всюду, где 

возможно нахождение конструкции. Элементы в эйлеровой сетке 

могут быть заполнены и воздухом и материалом, в том числе и 

частично. ALE-формулировка – промежуточный вариант между 

лагранжевой и ейлеровой постановкой. В ALE формулировке 

сетка двигается вместе с материалом (происходит адвекция сет-

ки). 

 Исполняемым файлом для LS-DYNA является Jobname.k-

входной файл, автоматически создаваемый ANSYS при исполне-

нии команды SOLVE. Файл содержит полную геометрию, 

нагрузки и характеристики материалов, присутствующие в базе 

данных ANSYS. Файл на 100% совместим с LS-DYNA.  
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 После запуска появляется DOS-окно с указанием параметров за-

дачи и с оценкой времени счета (на основе начального шага). 

Шаг по времени устанавливается автоматически, исходя из ми-

нимального текущего размера элемента и скорости звука в его 

материале. В процессе решения можно запросить уточненную 

оценку времени счета. 

 Довольно удобно сделано прерывание решения — его можно 

выполнить в любой момент с автоматическим созданием файла 

рестарта.  

 В постпроцессор ANSYS можно передать как напряжения, пере-

мещения и деформации, так и специфические параметры LS-

DYNA: суммарные контактные силы, кинетическую и иные 

энергии и т.д. Создаются не только полное напряженно-

деформированное состояние — файл *.rst, с возможностью ани-

мации, например по 100 шагам, но и особый файл *.his, включа-

ющий результаты, например 10 тыс. шагов для нескольких за-

данных узлов (с возможностью построения графиков).  

 

Среди особенностей программы ANSYS-LS-DYNA примени-

тельно к ОМД можно отметить следующие [7]: 

 модели анизотропной пластичности (Hill, Barlat); 

 абсолютно жесткий инструмент; 

 семь специальных типов контакта, включая термический кон-

такт; 

 автоматическая ориентация сегментов; 

 связанный термомеханический анализ; 

 анализ пружинения; 

 произвольные лагранжево-эйлеровые сетки; 

 исключение разрушихся элементов. 
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ГЛАВА 2 

 

ОСНОВЫ РАБОТЫ В ПРОГРАММЕ ANSYS/LS-DYNA  

ПРИМЕНИТЕЛЬНО К ПРОЦЕССАМ ОМД 

 

 

2.1. Описание графического интерфейса программы ANSYS/LS-

DYNA 

 

Графический интерфейс (рис. 2.1) служит для удобства работы 

пользователя в программе ANSYS/LS-DYNA, позволяет осуществ-

лять все необходимые действия для решения поставленной задачи. 

 

 
 

Рис. 2.1. Графический интерфейс программы ANSYS/LS-DYNA: 1 – 

графическое окно, 2 – главное меню (Ansys Main Menu), 3 – сервисное 

меню (Ansys Utility Menu), 4 – стандартное меню, 5 – линейка инстру-

ментов (Ansys toolbar), 6 – меню изменения вида модели на экране 
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Графический интерфейс пользователя включает в себя: 

1 – графическое окно; 

2 – главное меню (Ansys Main Menu); 

3 – сервисное меню (Ansys Utility Menu); 

4 – стандартное меню; 

5 – линейку инструментов (ANSYS toolbar); 

6 – меню изменения видов. 

 

Главное меню (Main Menu) позволяет осуществлять доступ ко 

всем основным модулям и операциям программы, начиная от созда-

ния модели и заканчивая выводом полученных результатов расчета на 

экран. 

Для решения задач ANSYS/LS-DYNA в первую очередь должен 

быть настроен фильтр Preferences (рис. 2.2) который расположен в 

самом начале главного меню. 

 

 
 

Рис. 2.2. Выбор параметров фильтра Preferences для решения за-

дач ANSYS/LS-DYNA 

 
Главное меню (Main Menu) состоит из следующих основных 

модулей (рис. 2.3): 

Модуль Preprocessor (рис. 2.3.а) предназначен для подготовки 

геометрической и конечно-элементной модели, определения типа 

элементов, модели материала и  других необходимых параметров. 
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Модуль Solution (рис. 2.3.б) предназначен для подготовки моде-

ли к расчету, определения ограничений и нагрузок, параметров вре-

мени расчета, выходных данных и проведение самого расчета. 

Модуль General Postproc (рис. 2.3.в) предназначен для графи-

ческого и текстового вывода на экран полученных результатов расче-

та, для определенного временного шага. 

Модуль TimeHist Postproc предназначен для графического и 

текстового вывода на экран полученных результатов расчета для все-

го времени расчета, как правило, в виде графиков ―исследуемый па-

раметр‖ - время. 

 

   
а б в 

 

Рис. 2.3. Основные модули и пункты главного меню (Ansys Main 

Menu): а – модуль препроцессорной подготовки, б – модуль реше-

ния, в – модуль постпроцессорной обработки результатов 
 

Модуль Preprocessor состоит из следующих основных пунктов. 

Element Type - выбор типов элементов, которые будут исполь-

зованы в модели. 



 

 24 

Real Constants - определение постоянных которые используют-

ся совместно с типами элементов. 

Material Props - выбор параметров моделей материалов и зада-

ние их характеристик. 

Modeling - создание геометрической модели. 

Meshing - присвоение атрибутов всем частям модели (тип эле-

мента, постоянные, модели материала) и создание конечно-

элементной модели. 

LS-DYNA Options - задание параметров модели применительно 

к программе LS-DYNA. 

Модуль Solution состоит из следующих основных пунктов. 

Constraints - определение ограничений частей, элементов или 

узлов модели. 

Initial - задание начальной скорости движения частей или узлов 

модели. 

Loading Option - задание нагрузок на части, элементы и узлы 

модели. 

Analysis option - задание опции расчета, параметров рестарта, 

контроля искажения и др. 

Time controls - задание временных параметров расчета: время 

завершения, массовое скалирование и др. 

Output Controls - определение выходных файлов параметров 

энергии, результирующих сил, перемещения узлов и элементов, ча-

стоты записи этих файлов.  

Write Jobname.k - сохранение k-файла для выполнения расчета 

в программе LS-DYNA. 

Solve - запуск процесса расчета. 

Модуль General Postproc состоит из следующих основных пунк-

тов. 

Read results - чтение сохраненных данных расчета для опреде-

ленного шага или в определенный момент времени. 

Plot results - вывод результатов расчета на экран в виде цветных 

контуров. 
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 List results - вывод результатов расчета на экран в текстовом 

виде. 

Сервисное меню (ANSYS Utility Menu) предназначено для ра-

боты с файлами модели, выбора необходимых объектов модели, 

управлением отображения модели на экране и др. (рис. 2.4). 

 

 
 

Рис. 2.4. Сервисное меню (ANSYS Utility Menu) 
 

File - стандартное меню для работы с файлами. 

Select - осуществление выбора необходимых объектов модели. 

List - вывод списков характеристик объекта в текстовом виде. 

Plot - отображение модели в виде точек, линий, плоскостей, 

объема и др. в зависимости от того из чего состоит модель. 

PlotCtrls - осуществление действия по отображению модели на 

экране. 

WorkPlane - управление рабочей плоскостью модели и систе-

мами координат. 

Parameters - определение базы данных в виде массивом, пере-

менных и др. 

Help – помощь. 

 

2.2. Единицы измерения 

 

Для работы в программе ANSYS/LS-DYNA необходимо кор-

ректно задавать все используемые единицы измерений. Размерность 

каждой единицы должна быть соответственной и согласовываться с 

общими правилами [8, 9]: 

- [усилие] = [масса]*[ускорение]; 

- [ускорение] = [длина]/[время
2
]. 

Примеры некоторых из согласованных единиц измерений при-

ведены в табл. 2.1. 
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Таблица 2.1 

Примеры согласованных единиц измерений 

 

№ масса длина время усилие напряж. плотн. 
Мод. 

Юнга 

Уск. 

св. пад. 

1 кг м с H Па 7,83е+3 2,1е11 9,8 

2 г см мкс 1е+7 Мбар 7,83 2,1 9,8е-10 

3 тонна мм с Н МПа 7,83е-9 2,1е5 9,8е3 

 
Система единиц измерений №1 соответствует системе СИ. В ря-

де случаев использовать ее не совсем удобно, например, при неболь-

ших размерах модели и при моделировании кратковременных про-

цессов. 

Система единиц измерений №2 обычно применяется в процес-

сах длящихся очень малое время (мкс и мс), например, в процессах 

взрыва (при использовании полной LS-DYNA). 

Система единиц измерений №3 наиболее удобна в процессах 

ОМД, поэтому все вводимые далее параметры будут соответствовать 

этой системе измерений. 

 

2.3. Операции управления моделью на экране 

 

Вращение – правая кнопка мыши + кнопка Ctrl. 

Перемещение – левая кнопка мыши + кнопка Ctrl. 

Масштабирование – колесико мыши. 

Масштабирование и вращение – средняя кнопка мыши + кнопка 

Ctrl. 

 

Выбор объектов геометрической модели осуществляется левой 

кнопкой мыши.  

Отмена выбранных объектов осуществляется переключением 

вида курсора при помощи правой кнопки мыши. 
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2.4. Основные этапы моделирования 

 

Выполнение процесса моделирования состоит из 3-х основных 

этапов: 

- препроцессорная подготовка; 

- решение задачи; 

- постпроцессорная обработка. 

Препроцессорная подготовка включает в себя создание гео-

метрической и конечно-элементной модели процесса, определение 

типов элемента, моделей материала, контактных параметров процес-

са, введение ограничений и нагрузок, действующих на модель, опре-

деление времени расчета и всех других необходимых параметров для 

выполнения расчета. 

Решение задачи позволяет запустить и контролировать процесс 

решения. 

Постпроцессорная обработка позволяет в графическом виде 

получить результаты выполненного расчета путем построения графи-

ков и эпюр исследуемых процессов, создания анимации процесса и 

прочее. 

В программе ANSYS/LS-DYNA в качестве препроцессора и 

постпроцессора используется типовые модули Ansys, а при решении 

задачи используется решатель программы LS-DYNA. 

 

2.5. Типы элементов Shell и Solid 

 

Программа ANSYS /LS-DYNA имеет несколько типов элемента. 

Для определения типов элемента в графическом интерфейсе ANSYS 

используется следующая команда: 

 

Ansys main menu → Preprocessor → Element Type → 

Add/Edit/Delete  

 

Необходимые типы элемента выбираются из библиотеки типов 

элемента (рис. 2.5). 
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При решении трехмерных задач ОМД в большинстве случаев 

используются типы элемента Solid 164 и Shell 163 [5]. 

Тип элемента Solid 164 представляет собой 8-и узловой объем-

ный элемент, позволяет использовать 2 подхода к интегрированию 

конечного элемента: пониженное интегрирования, когда используется 

одна точка интегрирования и полное интегрирование (рис. 2.6).  

 

 
 

Рис. 2.5. Библиотека типов элемента (выводится по кнопке Add) 

 
Пониженное интегрирование позволяет уменьшить время расче-

та, такой элемент устойчив к воздействию больших деформаций, но в 

тоже время требует включения контроля искажения типа песочных 

часов Hourglass. 

Полное интегрирование не требует контроля искажения, но уве-

личивает время расчета. 

 

 
 

Рис. 2.6. Опции типа элемента SOLID 164 
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Тип элемента Shell 163 представляет собой 3-х или 4-х узловой 

трехмерный оболоченный элемент с возможностями определения 

мембранных свойств. 

 Элемент дает возможность выбрать один из 12 элементных 

формулировок (рис. 2.7). 

 

 
 

Рис. 2.7. Опции типа элемента SHELL 163 

 
Элементная формулировка Hughes-Liu (1) использует пони-

женное интегрирование с некоторым контролем искажения hourglass. 

Элементная формулировка Belytschko-Tsay (0, 2) самая быстрая 

из всех формулировок (применяется по умолчанию). Использует по-

ниженное интегрирование элемента с контролем искажения hourglass. 

Не должна использоваться, когда элементы испытывают большие де-

формации. 

Элементная формулировка BCIZ Triangular Shell (3) основана 

на теории пластин Kirchhoff, включает пониженное интегрирование 

элемента. 

Элементная формулировка C
0
 Triangular Shell (4) основана на 

теории пластин Mindlin-Reissner, применяет пониженное интегриро-

вание. Формулировка довольно жесткая. 

Элементная формулировка Belytschko-Tsay membrane (5) ана-

лог Belytschko-Tsay, но без жесткости при изгибе. Использует пони-

женное интегрирование. Эффективна для большинства мембранных 

приложений. Применяется где образование складок нежелательно. 



 

 30 

Элементная формулировка S/R Hughes-Liu (6) аналог Hughes-

Liu, но применяет выборочное пониженное интегрирование, время 

расчета увеличено в 3-4 раза, формулировка позволяет избегать неко-

торого искривления формы элемента.  

Элементная формулировка S/R corotational Hughes-Liu (7) 

близка к формулировке S/R Hughes-Liu, имеет полное интегрирова-

ние. Рекомендуется если в задаче будут наблюдаться искажения фор-

мы.   

Элементная формулировка Belytschko-Leviathan (8) подобна 

Belytschko-Wong-Chiang, имеет пониженное интегрирование элемен-

та, но содержит контроль искажений.  

Элементная формулировка Fully-integrated Belytschko-Tsay 

membrane (9) полностью интегрированная мембранная элементная 

формулировка. Не имеет искажения формы, но медленная при расчете 

и более жесткая при деформировании. 

Элементная формулировка Belytschko-Wong-Chiang (10) со-

держит пониженное интегрирование, аналог Belytschko-Tsay, но ли-

шена недостатков при деформировании конструкции.   

Элементная формулировка Fast (corotational) Hughes-Liu (11) 

аналог Hughes-Liu, использует пониженное интегрирование и corota-

tional систему.  

Элементная формулировка Fully-integrated Belytschko-Tsay 

(12) полностью интегрированная формулировка, не нуждается в кон-

троле искажения формы. 

Для процессов ОМД рекомендуется использовать формули-

ровки 10 и 12. 

Shell 163 предусматривает ввод следующих констант (Real 

Constants) (рис. 2.8). 

 

Ansys main menu → Preprocessor → Real Constants  
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Рис. 2.8. Определение констант для элемента shell 163 

 
SHRF – поправочный коэффициент для поперечных касательных 

напряжений, по умолчанию, рекомендуется значения 5/6. 

NIP – количество точек интеграции по толщине элемента. По 

умолчанию устанавливается значение 2. В процессах ОМД в зави-

симости от величины предполагаемой деформации рекомендует-

ся назначение 3, 5 или 7 точек интеграции по толщине. 

T1-T4 – толщина оболочки в каждом из 4-х узлов. 

 

2.6. Модели материалов для процессов ОМД 

 

ANSYS/LS-DYNA включает большой ряд моделей материала. 

Ниже приведены модели материала, которые наиболее часто исполь-

зуются при моделировании процессов ОМД (табл. 2.2). 
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Ansys main menu → Preprocessor → Material Props → Material 

Models 

 
В диалоговом окне Define Material Model Behavior можно вы-

брать необходимые модели материалов. 

 

 
 

Рис. 2.9. Окно выбора модели материала 

 
Таблица 2.2 

Модели материалов для процессов ОМД 

 

№ Модель 

матер-ла 

Общий вид и путь команды Параметры 

материала 

1 Изотроп-

ный упру-

гий 

 

LSDYNA→Linear→Elastic→Isot

ropic 

DENS – плотность; 

EX – модуль Юнга; 

NUXY – коэффици-

ент Пуассона. 

 

График на рис. 2.10.а 
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Применяется для описания материала, который подчиняется 

линейному закону Гука. Используется для металлических элемен-

тов конструкции работающих в упругих диапазонах*. 

2 Билиней-

ный изо-

тропный 

 

LS-DYNA→Nonlinear→Inelastic→ 

Kinematic Hardening→Bilinear 

Kinematic 

 

DENS – плотность; 

EX – модуль Юн-

га; 

NUXY – коэффи-

циент Пуассона; 

Yield Stress – пре-

дел текучести; 

Tangent Modulus - 

модуль пластично-

сти. 

 

График на рис. 

2.10.б 

Предел текучести -

Т  

Модуль пластич-

ности 
Т

Т









В

В

  

Используется для описания упругопластических деформаций. 

Кривая модели состоит из двух элементов – упругой составляющей 

и пластической составляющей.  

Билинейная модель может быть изотропная и кинематическая. 

Эти модели отличаются наличием/отсутствием эффекта Баушинге-

ра. 

При определении модуля пластичности нужно учесть, что рас-

чет нужно вести в истинных (лагранжевых), а не в инженерных па-

раметрах [10].   
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3 Пластиче-

ский ки-

нематиче-

ский 

 

LSDYNA→Nonlinear→Inelastic

→Kinematic Hardening→Plastic 

Kinematic 

DENS – плотность; 

EX – модуль Юнга; 

NUXY – коэффици-

ент Пуассона; 

Failure Strain - де-

формация разруш. 

График на рис. 

2.10.в 

 

 

 

 Модель отличается от билинейных моделей возможностью 

введения дополнительных параметров, таких как, зависимость от 

степени деформации, определение деформации разрушения и др. 

Изотропная, кинематическая или комбинированная модель изо-

тропного и кинематического упрочнения с зависимым от степени 

деформации и разрушением. Изотропные и кинематические комби-

нации могут варьироваться, регулируя параметр упрочнения β меж-

ду 0 (только кинематическое упрочнение) и 1 (только изотропное 

упрочнение). 

4 Пластиче-

ский в 

степенном 

виде 

 

LSDYNA→Nonlinear→Inelastic

→Power Law 

DENS – плотность; 

EX – модуль Юнга; 

NUXY – коэффици-

ент Пуассона; 

Strength Coeff - ко-

эффициент прочн.; 

Hardening Coef - ко-

эффициент упроч-

нения. 

График на рис. 

2.10.г 
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Пластическая модель, зависимая от степени деформации обыч-

но используется для металла и пластического анализа. Модель 

представлена упруго-пластическим поведением с изотропным 

упрочнением, имеет степенную зависимость, которая включает 

Cowper-Symonds множители для расчета степени деформации. 

5 Попереч-

но анизо-

тропный 

упрочня-

ющий 

 

LSDYNA→Nonlinear→Inelastic→

Anisotropic Hardening→Transverse 

Anisotropic 

DENS – плотность; 

EX – модуль Юн-

га; 

NUXY – коэффи-

циент Пуассона; 

Load Curve – кри-

вая нагружения. 

Полностью итерационная анизотропная пластическая модель 

только для оболочных и 2–D элементов. В этой модели в поле 

функции дается параметр Hill и есть понижение для случая плоско-

го напряженного состояния. 

6 3-х пара-

метрная 

BARTAL 

 

LSDYNA→Nonlinear→Inelastic→

Bartal 

DENS – плотность; 

EX – модуль Юн-

га; 

NUXY – коэффи-

циент Пуассона; 

Hardening Rule - 

правило упрочне-

ния; 

Yld Strs – предел 

текучести; 

Bartal Expon - экс-

понента Bartal. 
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Анизотропная пластическая модель (развитая Barlat и Lian) ис-

пользуется для моделирования алюминиевого листа в условиях 

плосконапряженного состояния. Возможны экспоненциальные и 

линейные правила упрочнения. 

7 Твердый 

(Rigid) 

 

LSDYNA→Rigid Material 

DENS – 

плотность; 

EX – модуль 

Юнга; 

NUXY – Ко-

эффициент 

Пуассона. 

 

Используется для определения твердого (недеформируемого) 

материала. В ОМД материал Rigid применяется для определения 

свойств недеформируемого инструмента (матрицы, пуансона). 

* - может применяться для тестовых задач  

 

 
 

Рис. 2.10. Графики моделей материала: а − изотропная упругая модель; б − 

билинейная изотропная (кинематическая) модель, в − пластическая кине-

матическая модель с коэффициентом разрушения, г − пластическая модель 

в степенном виде 
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2.7. Создание геометрической модели 

 

Геометрическая модель может быть создана как внутренними 

возможностями программы ANSYS, так и импортированием геомет-

рии из других программ.  

Создание модели может осуществляться как снизу вверх, так и 

сверху вниз. При создании модели снизу вверх сначала создаются 

точки, затем, на основе точек, линии, далее поверхности и объемы. 

При создании модели сверху вниз сразу строят поверхности и объе-

мы, используют операции копирования, масштабирования, а также 

булевские операции.  

Например, для создания цилиндра используется команда: 

 

Ansys main menu → Preprocessor → Modeling → Create → Vol-

umes → Cylinder → By Dimensions 

 

В открывшемся окне вводятся значения радиуса основания ци-

линдра, высота цилиндра и угол поворота окружности основания ци-

линдра. 

 

Для создания плоскости: 

Ansys main menu → Preprocessor → Modeling → Create → Are-

as → Rectangle → By Dimensions 

 

В открывшемся окне вводятся координаты крайних точек пл-ти. 

Более подробную информацию по созданию геометрических 

моделей в программе ANSYS можно узнать из источника [11, 12]. 

 

2.8. Управление видами 

 

Для управления видами модели может использоваться меню из-

менения вида (см. рис. 2.1). В этом окне можно выбрать один из 6 ос-
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новных видов расположения модели, изометрический вид, осуществ-

лять приближение-удаление модели и др. 

 

2.9. Создание конечно-элементной сетки. Меню MeshTool 

 

Процедура создания конечно-элементной сетки состоит из сле-

дующих этапов: 

1. Определение атрибутов геометрическим частям модели; 

2. Установка параметров качества сетки; 

3. Создание сетки. 

Наиболее удобным для построения сетки является использование 

сеточного меню MeshTool (рис. 2.11). 

Для вызова панели MeshTool используется следующая команда: 

 

Ansys main menu → Meshing → MeshTool 

 

2.10. Определение частей 

 

После создания конечно-элементой сетки в ANSYS/LS-DYNA 

требуется определение частей (Part). Каждой части (Part) соответству-

ет определенный геометрический объект, материал, действующая по-

стоянная и тип конечного элемента. 

 

 
 

Рис. 2.12. Панель определения частей (Part) 
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Сеточное меню содер-

жит следующие основные 

секции: 

Секция Element Attrib-

utes (а) предназначена для 

присвоения атрибутов опре-

деленным частям геометриче-

ской модели (типа элемента, 

модели материала, действу-

ющих постоянных).  

Секция Size Controls (б) 

предназначена для разбиения 

кромок модели на необходи-

мые длины элементов. 

Секция Mesh (в) предна-

значена для выбора типа 

наносимой сетки и непосред-

ственного нанесения сетки на 

геометрическую модель. 

 

 
 

Рис. 2.11. Сеточное меню MeshTool:  

а – секция Element Attributes,  

б – секция Size Controls,  

в – секция Mesh 
 

2.11. Определение контакта 

 

Определение контакта необходимо для исключения взаимного 

проникновения геометрических объектов сквозь друг друга. 

Команда для определения контакта: 
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Ansys main menu → Preprocessor → LS-DYNA Options →  

Contact → Define Contact 

 

В окне определения контактных параметров (рис. 2.13) задается: 

- тип контакта; 

- коэффициенты трения (статический, динамический); 

- параметры демпфирования и вязкости. 

Контакт поверхностей в ANSYS/LS-DYNA позволяет модели-

ровать большое разнообразие взаимодействий между компонентами и 

частями модели. 

В программе ANSYS/LS-DYNA контакт представлен несколько 

иначе, чем в других типах анализа ANSYS. В обычном ANSYS кон-

такт представлен фактическими контактными элементами. В 

ANSYS/LS-DYNA нет контактных элементов, а указываются только 

компоненты и части (part) модели, что значительно облегчает пользо-

вателю процесс определения контакта. 

 

 
 
Рис. 2.13. Панель определения контактных параметров 

 
Для описания взаимодействия между частями со сложной гео-

метрией в ANSYS/LS-DYNA включены несколько контактных типов 

[5]: 
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1. Single Surface (тип контакта - единственная поверхность). 

Контакт определяется когда поверхность одного тела входит во 

взаимодействие с собой или с поверхностью другого тела. Преиму-

щество данного контакта в том, что не требуется указания контакт-

ных тел. Применяется для самоконтакных задач или задач с боль-

шими деформациями, где области контакта заранее неизвестны. 

2. Nodes to Surface (тип контакта - узлы-поверхность). 

Контакт определяется, когда в контактный узел проникает глав-

ная (target) поверхность. Контакт применяется для контакта между 

двумя поверхностями. Особенно эффективно, когда меньшая по-

верхность приходит в контакт с большей поверхностью. 

3. Surface to surface (тип контакта – поверхность - поверхность). 

Контакт определяется, когда поверхность одного тела проникает 

в поверхность другого. Контакт применяется для произвольно рас-

положенных тел, которые могут иметь большие области контакта и 

эффективны для тел которые подвержены большому относительно-

му скольжению относительно друг-друга. 

Каждый из приведенных выше типов контакта включает в себя 

опции контакта:  

1. General contact – быстрый и надежный контакт, использую-

щий простые контактные алгоритмы, но требует контроля контакт-

ной ориентации поверхностей. Для твердых элементов ориентация 

поверхностей устанавливается автоматически. 

2. Automatic contact имеет наиболее общие контактные алгорит-

мы. В отличие от General contact контакт проверяется по обеим сто-

ронам элементов оболочки. Контакт ограничен глубиной контакта, 

которую при необходимости можно изменить. 

3. Eroding contact устанавливается когда поверхностные элемен-

ты в процессе контроля могу разрушаться, после этого контакт пе-

редается во внутренние элементы. Контакт используется с твердыми 

элементами, в задачах проникновения и приложений, где имеется 

разрушение поверхности.  

4. Rigid contact - используется в случае когда все тела твердые. 
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5. Tied contact позволяет связать узлы контактных поверхностей. 

Поверхности должны быть параллельны. В результате главная 

(tanget) поверхность подчиняет контактные узлы другой поверхно-

сти и поверхности деформируются совместно.  

6. Tiebreak contact аналогичен предыдущему за исключением то-

го, что контактные узлы привязаны к главной поверхности пока не 

достигнут критерий разрушения. Требуется определение значения 

критерия разрушения. 

7. Forming contact основан на автоматических контактных типах 

и используется в процессах обработки металлов давлением. Ин-

струмент задается как главная (tanget) поверхность, заготовка как 

подчиненная поверхность.  

При определении контактных параметров также требуется вести 

ряд значений: 

Static Friction Coefficient – статический коэффициент трения; 

Dynamic Friction Coefficient – динамический коэффициент тре-

ния; 

Exponential Decay Coefficient – коэффициент экспоненциального 

затухания; 

Viscous Friction Coefficient – коэффициент вязкого трения. Поз-

воляет ограничить силы трения, которая не может превышать значе-

ния 3/Т , где Т  - предел текучести для использованного материа-

ла; 

Viscous Damping Coefficient – коэффициент демпфирования, ко-

торый устанавливается в процентах от критического. Как правило, 

для процессов обработки металлов давлением его значение при-

нимают равным 20%. 

После определения всех параметров в панели определения кон-

тактных параметров (см. рис. 2.13) для большинства контактных ти-

пов требуется определение контактного и главного (целевой, tanget) 

компонента (рис. 2.14).  В процессах ОМД контактным компо-

нентом (Сontact Component) является заготовка, а целевым 

компонентом (Tanget Component) является инструмент. Для 
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примера рис. 3.1, где контактным компонентом является заготовка 1, 

а целевым компонентом – плоскости 2 и 3. 

 

 
 
Рис. 2.14. Опции контакта, выбор контактных объектов 

 
2.12. Определение нагрузки 

 

В программе ANSYS/LS-DYNA все вводимые значения должны 

задаваться с привязкой к значениям времени. 

В процессах ОМД нагрузка, как правило, прикладывается на не-

деформируемый (rigid) инструмент в виде силы или скорости. По 

возможности параметр, определяющий нагрузку, должен соответ-

ствовать реальному процессу. 

Рекомендуется задавать следующий график нагрузки (рис. 2.15). 

 

 

Обозначение на графике: 

Vmax – максимальная 

скорость 

t1 – время разгона; 

t2 – время завершения. 

 

Рекомендуемые значе-

ния: 

Vmax = 2-5 м/с 

t1 = 0,001-0,005 с 

 

 
Рис. 2.15. График нагрузки и рекомендуемые значения для процессов ОМД 

 

В случае, когда на инструмент прикладывается скорость, начи-

нать моделирование нужно с нулевого значения, как показано на гра-
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фике (рис. 2.15). При этом максимальная скорость движения инстру-

мента должна быть ограничена значениями 2-5 м/с [7, 13] (рекомен-

дуется величина 2 м/с). 

В случае, когда на инструмент прикладывается параметр отлич-

ный от скорости (например, перемещение, усилие и т.п.) нужно кон-

тролировать скорость движения инструмента в процессе расчета, ее 

значение не должна превышать параметра 2-5 м/с. 

Для задания кривой нагружения в программе ANSYS/LS-DYNA 

используются массивы данных: 

 

Ansys utility menu → Parameters → Array Parameters → De-

fine/Edit 

 

В открывшемся меню (Add) рис. 2.16 можно задать название па-

раметра и величину массива. Для определения кривой необходимо за-

дать 2 массива: скорость и время. Размеры обоих массивов будут со-

ответствовать размеру 3х1. 

Параметры массива вводятся в следующем окне (рис. 2.17). 

Примеры определения массива (Perem – скорость, Time – время): 

Perem = 0, -1000, -1000; Time = 0, 0.001, 0.05. 

 

 
 

Рис. 2.16. Окно определения параметров массива 
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Рис. 2.17. Окно определения значения массива 

 
Нагружение модели (части) осуществляется при помощи команды: 

 

Ansys main menu → Solution → Loading Options → Specify 

Loads 

 

В окне определения нагрузки (рис. 2.18) вводятся: 

- определение/удаление/просмотр нагрузки (Load Options); 

 

 
 

Рис. 2.18. Окно определения нагрузки 
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- вид нагрузки (Load Labels); 

- номер части или имя компонента (Component name or PART num-

ber); 

- имя параметра временной оси; 

- имя параметра оси нагружения. 

 

В большинстве случаев в процессах ОМД нагрузка прикла-

дывается к твердым телам (которые задают инструмент) и опре-

деляются как части (part). Основные виды нагрузок для твердых тел 

приведены в таблице 2.3. 

 

Таблица 2.3 

Основные виды нагрузок для твердых тел и их обозначения 

 

Вид нагрузки Обозначение метки по осям 

Сила RBFX, RBFY, RBFZ 

Моменты RBMX, RBMY, RBMZ 

Перемещения RBUX, RBUY, RBUZ 

Поворот RBRX, RBRY, RBRZ 

Скорости RBVX, RBVY, RBVZ 

Угловые скорости RBOX, RBOY, RBOZ 

 

 Пример: для задания скорости движения пуансона (представ-

ленного как твердое тело) вдоль оси Z мы должны использовать мет-

ку RBVZ. 

Номер части (Part Number) соответствует номеру присвоенной 

ранее инструменту в меню Part. 

 Имя параметра (parameter name) соответствуют именам задан-

ным ранее в массиве. 

 

 

 



 

 47 

2.13. Определение ограничений 

 

Ограничения применяют для фиксации узлов или элементов мо-

дели, как в поступательном движении, так и при вращении.  

Для приложения ограничений служит команда: 

 

Ansys main menu → Solution → Constraints → Apply → On 

Lines/Areas/Nodes 

 

Такие ограничения действуют лишь на деформируемые тела. 

Ограничения на недеформируемые (твердые) тела задаются при опре-

делении свойств материала (таблица 2.2, п.7). 

Используя пункты меню Translation Constrain Parameter (ограни-

чение перемещения) и Rotational Constrain Parameter (ограничение 

вращения) можно задать соответствующие ограничения (табл. 2.4). 

 

Таблица 2.4 

Ограничения твердых тел 

 

Направления ограничений вдоль осей 

No constraints Без ограничений 

X displacement/ X rotation Ограничение X перемещения/вращения 

Y displacement/ Y rotation Ограничение Y перемещения/вращения 

Z displacement/ Z rotation Ограничение Z перемещения/вращения 

X and Y disps/ X and Y ro-

tate 

Ограничение X и Y перемещения/ вра-

щения 

Y and Z disps/ Y and Z rotate 
Ограничение Y и Z перемещения/ вра-

щения 

Z and X disps/ Z and X rotate 
Ограничение Z и X перемещения/ вра-

щения 

All disps/ All rotation 
Полное ограничение перемеще-

ния/вращения 
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2.14. Определение дополнительных параметров 

 

2.14.1. Определения параметра контроля Hourglass 

 

Параметр контроля искажения Hourglass применяется для эле-

ментов с пониженным интегрированием. Назначение параметра – по-

давлять искажения формы элементов.  

Команда для определения параметра контроля Hourglass: 

 

Ansys main menu → Solution → Analysis Options → Hourglass 

Ctrls → Local 

 

Окно определения параметров контроля Hourglass позволяет 

ввести тип контроля Hourglass (VAL1), коэффициент подавления ис-

кажения формы элементов (VAL2), квадратичные и линейные коэф-

фициенты объемной вязкости (VAL3,4) и др. 

Для процессов ОМД рекомендованные значения типа кон-

троля Hourglass (VAL1) значения 4 и 5. Остальные коэффициенты 

по умолчанию. Более подробно про параметры контроля Hourglass 

можно узнать из источника [8]. 

 

 
 

Рис. 2.19. Окно определения параметров контроля Hourglass 
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2.14.2. Определения время завершения анализа 

 

Время завершения анализа устанавливается командой:  

 

Ansys main menu → Solution → Time Controls → Solution Time 

 

Время завершения анализа должно быть не больше (можно 

меньше), чем задано кривой нагружения (см. рис. 2.15). 

 

2.14.3. Изменение временного шага 

 

Временной шаг или такт является единицей времени которая 

обеспечивает стабильность расчета. В ряде случаев, этот шаг можно 

искусственно повысить, что приведет к уменьшению времени расче-

та. Характерно обратнопропорциональная зависимость времени рас-

чета от величины временного шага. 

Величину временного шага можно искусственно повысить в 

случаях если: 

-  максимальная скорость движения отдельных частей модели 

меньше 2 м/с; 

- расчет осуществляется для предварительной тестовой модели; 

- время расчета нереально большое. 

В случае увеличения временного шага необходимо: 

- использовать правильную сетку (для оболочных элементов – 4-х 

узловою, для объемных – 8-и узловую) с адекватными соотношения-

ми сторон; 

- отслеживать появление динамических эффектов, например, кон-

тролируя кинетическую и внутреннюю энергию, кинетическая энер-

гия не должна превышать внутреннюю более чем на 5% [7]. 

Для изменения временного шага используется команда: 

 

Ansys main menu → Solution → Time Controls → Time Step 

Ctrls 
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В появившемся окне (рис. 2.20) можно внести измененное зна-

чение временного шага (опция Mass scaling time step size). 

Для этого: 

1. запускают процесс решения задачи с временным шагом по 

умолчанию; 

2. в окне выполнения процесса (см. далее рис. 2.22) отмечают 

значение time step; 

3. процесс останавливают; 

4. значение временного шага пересчитывают исходя из коэффи-

циента увеличения; 

5. новое значение записывают в окно масштабирование времен-

ного шага; 

6. процесс запускают уже с измененным временным шагом. 

 

 
 

Рис. 2.20. Окно масштабирования временного шага 

 

Как показывает практика моделирования процессов 

ОМД, временной шаг можно увеличивать до 10-30 раз без 

значительной потери качества результатов (в случае применения 

ранее описанных условий).  

  
2.14.4. Определение частоты записи выходных файлов 

 

Результаты расчета будут записаны программой с некоторым 

интервалом. Для определения количества шагов записи результатов 

служит следующая команда: 
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Ansys main menu → Solution → Output Controls → File Output 

Freq → Number of Steps 

 

В этом окне по умолчанию задано число шагов записи равное 

100 для постпроцессора POST1 и 1000 для постпроцессора POST26. 

 

 2.14.5. Определение дополнительных выходных файлов (фай-

лы ASCII) 

 

Выходные файлы ASCII позволяют сохранить в процессе расче-

та дополнительные выходные параметры для последующего просмот-

ра их во временном постпроцессоре POST26. 

 

Ansys main menu → Solution → Output Controls → ASCII Out-

put 

 

В открывшемся окне (рис. 2.21) можно выбрать различные вы-

ходные данные расчета.  

 

 
 

Рис. 2.21. Окно определения дополнительных выходных файлов  

ASCII 
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Вот некоторые из выходных файлов ASCII: 

Global data - общие данные; 

Material energy - данные энергии материала; 

Resultant force - результирующие силы; 

Nodal interface - силы в узлах элемента; 

Element data - данные по элементам; 

Nodal data - данные по узлам. 

 

2.15. Создание k-файла 

 

Для запуска расчета в решателе LS-DYNA необходимо создание 

k-файла, представляющего собой текстовый файл со всей информаци-

ей по модели. 

Для создания k-файла используется команда: 

 

Ansys main menu → Solution → Write Jobname.k 

 

Использование данной команды позволяет сохранить результа-

ты в разных форматах: 

0 – формат LS-DYNA; 

1 – формат ANSYS; 

2 – формат ANSYS и LS-DYNA. 

Использование формата LS-DYNA позволит сохранить резуль-

таты в форматах пригодных для их чтения в препостпроцессоре LS-

PREPOST. 

Отметим, что поскольку k-файл имеет текстовый вид, то легко 

поддается правке в любом текстовом редакторе (блокноте), что поз-

воляет при необходимости быстро исправить в нем данные и запу-

стить на расчет. 

 Также отметим, что k-файл сохраняется автоматически при за-

пуске процесса расчета, но при этом формат будет соответствовать 

только формату ANSYS. 
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2.16. Решение задачи 

 

Запуск задачи на расчет осуществляется по следующей команде: 

 

Ansys main menu → Solution → Solve 

 

После вывода окна Status, процесс перейдет к решателю про-

граммы LS-Dyna, и появиться окошко процесса решения (рис. 2.22). 

 

 
 

Рис. 2.22. Окошко выполнения процесса 

решения в решателе программы LS-Dyna 

 

В этом окошке отображается вся необходимая информация, та-

кая как: 

- версия решателя; 

- минимальный шаг по времени; 

- требуемая величина оперативной памяти; 

- энергетические параметры процесса; 

- временные параметры процесса (текущий временной шаг). 

Программа имеет специальные ключи для контроля  и заверше-

ния процесса решения (для вызова которых нужно нажать сочетание 

клавиш Ctrl + C): 

Sw1 – завершить процесс решения на текущем шаге (с сохране-

нием всей информации); 
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Sw2 – вывести на экран оставшееся и полное время процесса и 

продолжить выполнение данного процесса. 

 

 

2.17. Постпроцессорная обработка POST1 

 

Постпроцессорная обработка, следующая за стадиями препро-

цессорной подготовки и получения решения, позволяет обратиться к 

результатам решения и интерпретировать их нужным образом, ис-

пользуя набор команд и возможности интерфейса. Результаты реше-

ния (применительно к задачам инженерной механики) включают зна-

чения перемещений, напряжений, деформаций, энергии и др. Резуль-

татом работы программы может быть как графическое, так и таблич-

ное представление результатов. Графическое изображение можно вы-

вести на монитор, преобразовать в файлы с различными расширения-

ми (форматы BMP, JPEG и др.). Программа позволяет  создать AVI-

файлы, что позволяет наблюдать анимацию процесса. На стадии по-

лучения решения результаты записываются в базу данных программы 

ANSYS  и в так называемый файл результатов. Результаты, получен-

ные на каждом дополнительном шаге решения, накапливаются как 

наборы данных [14]. 

Существуют две возможности обратиться к записанным резуль-

татам для последующей постпроцессорной обработки. Для ознаком-

ления с определенным набором полученных данных, которые отно-

сятся ко всей модели или ее части,  можно использовать постпроцес-

сор общего назначения (POST1). Или можно использовать постпро-

цессор истории нагружения (POST26) для выделения из массивов ре-

зультатов нужных параметров, например, узловых перемещений или 

напряжений в элементе. При считывании данных из файла, они со-

храняются в базе данных программы ANSYS, что на стадии постпро-

цессорной обработки дает возможность иметь доступ ко всем вход-

ным параметрам модели (геометрии, свойствам материалов, нагруз-

кам и т.д.). Кроме того, средства графического отображения инфор-
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мации включают векторное представление, профили результатов 

вдоль заданной кривой. При векторном представлении используются 

отрезки со стрелками, чтобы показать как абсолютное значение, так и 

направление векторной величины, например, вектора перемещения. 

Профиль результатов представляет собой график, который показыва-

ет изменение полученных величин в зависимости от заданного поль-

зователем пути [14].  

Для извлечения данных по результатам расчета применяется 

следующая команда: 

 

Ansys main menu → General Postproc → Read Results → First 

Set / Next Set / Last Set / By Pick… 

 

Последняя опция выбирается исходя из того, какой шаг решения 

хотим открыть First Set – первый шаг, Last Set – последний шаг, By 

Pick – указать шаг. 

Для просмотра контуров деформированной формы применяется 

следующая команда: 

 

Ansys main menu → General Postproc → Plot Results → Contour 

Plot → Nodal Solu 

 

В появившемся окне (рис. 2.23) можно выбрать параметр, по ко-

торому интересует просмотр результатов.  

 

2.18. Постпроцессорная обработка POST26 

 

Постпроцессор истории нагружения POST26 (для результатов, 

зависящих от времени), дает возможность представить полученные 

данные расчета, например, узловые перемещения, напряжения или 

силы реакций, в виде зависимостей от времени или от шагов нагру-

жения. Эти данные доступны для обозрения в графической или таб-

личной форме [14].  
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Рис. 2.23. Окно выбора данных по узлам модели 

 

 
Загрузка данных в постпроцессор истории нагружения выполня-

ется по команде:  

 

Ansys main menu → TimeHist Postproc 

 

В результате появляется окно истории нагружения (рис. 2.24). 

Данное окно позволяет загружать базу с сохраненными резуль-

татами, строить графики зависимостей исследуемых значений от вре-

мени, выводить табличные значения полученных данных и т.п. 

Для чтения сохраненных дополнительных данных базы ASCII 

используются следующие команды: 

 

Ansys main menu → TimeHist Postproc → Read LSDYNA Data 

→ RCFORC file / MATSUM file … 

Ansys main menu → TimeHist Postproc → Variable Viewer 
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Рис. 2.24. Окно истории нагружения 

 
Команды позволяют загрузить сохраненную базу данных по 

требуемым параметрам, назначить интересующие параметры и через 

окно истории нагружения (рис. 2.24) построить интересующий гра-

фик. 
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ГЛАВА 3 

 

УЧЕБНЫЙ ПРИМЕР РЕШЕНИЯ ЗАДАЧИ В ПРОГРАММЕ  

ANSYS/LS-DYNA 

 

 

Моделирование процесса осадки цилиндрической заготовки 

 

Задача 

Цилиндрическая заготовка 1 диаметром D1=60 мм и высотой 

H1=80 мм (рис. 3.1) сжимается под воздействием двух плит – по-

движной 3 и неподвижной 2, в процессе осадки заготовка деформиру-

ется и ее размеры становятся следующими: диаметр D2 и высота H2. 

В качестве материала используем материал со следующими ме-

ханическими характеристиками: Т = 250 МПа, В = 280 МПа,   = 

30%,   = 0,3. 

По результатам моделирования требуется определить напря-

женно деформированное состояние материала заготовки и энергоси-

ловые параметры процесса осадки. 

Учебный пример выполнен в программе ANSYS/LS-DYNA с 

подробным описанием всех операций. 

 
Рис. 3.1. Геометрическая модель процесса осадки цилиндрической заго-

товки в начале процесса (а), в конце процесса (б): 1 – заготовка, 2 - нижняя 

неподвижная плоскость, 3 – верхняя подвижная плоскость 
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3.1. Начальные установки для сохранения вводимых данных 

 

Выберем папку, в которые будут сохраняться все данные расчета: 

 

Ansys utility menu → File → Ghange directory 

 

Откроется окно Change Work-

ing Directory как показано на 

рис. 3.2. 

1. Выберите папку [А] для 

сохранения ваших файлов 

(папка предварительно 

должна быть создана); 

2. Нажмите кнопку Ok [Б]. 

Все ваши файлы (файлы моде-

ли, расчетов и др.) будут нахо-

диться в данной папке. 

 

 
 

Рис. 3.2. Выбор рабочей 

папки для сохранения дан-

ных 

 
3.2. Определение начальных установок 

 

Установим опции проведения явного динамического анализа в про-

грамме ANSYS/LS-DYNA: 

  

Ansys main menu → Preference 

 

Откроется окно Preferences for GUI Filtering (рис. 3.3). 

 1. Поставьте галочку на Structural [А]; 

 2. Выберите LS-DYNA Explicit [Б]; 

3. Нажмите кнопку OK [В]. 
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Рис. 3.3. Исходные установки для выбора опций явного анализа 

 
3.3. Определение типов элементов 

 

Выберем типы конечных элементов, на которые будут разбиты части 

модели: 

  

Ansys main menu → Preprocessor → Element Type → 

Add/Edit/Delete 

 

Откроется окно Element Types 

(рис. 3.4). 

1. Нажмите кнопку Add [А]; 

Откроется окно Library of El-

ement Types (рис. 3.5). 

2. Выберите в правом окне 

―Thin Shell 163‖ [Б]; 

3. Нажмите кнопку ―Apply‖ 

[В]; 

4. Выберите в правом окне 

―3D Solid 164‖ [Г]; 

 

 

 
 

Рис. 3.4. Определение типа элемента 



 

 61 

5. Нажмите кнопку ―Ok‖ [Д]; 

6. Нажмите кнопку ―Close‖ [Е] (рис. 3.4). 

 

 

 
 

Рис. 3.5. Выбор типа элемента из библиотеки 

 

 
3.4. Определение действующих постоянных 

 

Определим действующие постоянные модели: 

  

Ansys main menu → Preprocessor → Real Constants 

 

Откроется окно Real Constants (рис. 3.6). 

1. Нажмите кнопку Add [А]; 

Откроется окно Element Type for Real Constants (рис. 3.7). 

2. Выберите ―Type 1 SHELL163‖ [Б]; 

3. Нажмите кнопку ―OK‖ [В]. 

4. В окне Real Constants Set Number 1 (рис. 3.8) нажмите ―Ok‖ [Г]; 

Откроется окно Real Constants Set Number 1 (рис. 3.9). 

5. Введите Shear factor (фактор сдвига) [Д] − 5/6; 

6. Введите No. of integration pts. (количество точек интеграции) [Е] 

− 1; 
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7. Введите Thickness at node 1 (толщина в узле 1) [Ж] − 1 (остальные 

ячейки толщин в зонах 2,3 и 4 будут заполнены автоматически в 

процессе сохранения k-файла); 

8. Закройте окно ―ОК‖ [З]; 

    9. Закройте окно ―Close‖ [И] (рис. 3.6). 

 

 
 

Рис. 3.6. Определение 

действующих постоянных 

 

 
 

Рис. 3.7. Определение ти-

па элемента для назначе-

ния действующих посто-

янных 

 

 
 

Рис. 3.8. Назначение номера дей-

ствующих постоянных 
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Рис. 3.9. Введение параметров 

действующих постоянных 

 
3.5. Определение параметров моделей материала 

 

Определим параметры моделей материала: 

 

Ansys main menu → Preprocessor → Material Props → Material 

Models 

 

Определяем свойства материала цилиндрической заготовки. 

Откроется окно Define Material Model Behavior (рис. 3.10). 

1. В правой стороне окна Material Models Available (доступные 

модели материалов) двойным щелчком выберите: 

LS-DYNA →  Nonlinear → Inelastic → Kinematic Hardening → 

Binear Kinematic 

 Откроется окно Bilinear Kinematic Material Properties for Mat… 

(рис. 3.11). 

2. Введите DENS (плотность материала) [А] − 7.85e-9; 

3. Введите EX (модуль Юнга) [Б] − 2e5; 

4. Введите NUXY (коэффициент Пуассона) [В] − 0.3; 
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Рис. 3.10. Определение модели материала 

 
5. Введите Yield Stress 

(предел текучести) [Г] − 

250; 

6. Введите Tangent Modu-

lus (модуль пластично-

сти) [Д] − 430; 

7. Нажмите Ok [Е]. 

 

 
 

Рис. 3.11. Ввод параметров для били-

нейного кинематического свойства ма-

териала 

 
Определяем свойства материала нижней плоскости (неподвиж-

ной). 

 

8. В окне Define Material Model Behavior (рис. 3.10) выберите Mate-

rial [Ж] → New Model.. 

Откроется окно Define Material ID. 

9. Нажмите ―ОК‖; 
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10. В правой стороне окна Material Models Available двойным 

щелчком выберите: 

LS-DYNA →  Rigid Material 

Откроется окно Rigid Properties for Material Number 2 (рис. 3.12). 

 
 

Рис. 3.12. Ввод параметров для недеформируемого (rigid) материала 

 

11. Введите DENS (плотность материала) [К] − 7.85e-9; 

12. Введите EX (модуль Юнга) [Л] − 2e5; 

13. Введите NUXY (коэффициент Пуассона) [М] − 0.3; 

14. В пункте Translation Constraint Parameter выберите All disps. [Н] 

(Запрещаем все перемещения); 

15. В пункте Rotational Constraint Parameter выберите All rotations 

[O] (Запрещаем все вращения); 

16. Нажмите Ok [П]. 

 

Определяем свойства материала верхней плоскости (подвиж-

ной) 

 

17. В окне Define Material Model Behavior (рис. 3.10) выберите Ma-
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terial [Ж] → New Model. 

18. Нажмите ―ОК‖ 

Откроется окно Define Material ID. 

19. В правой стороне окна Material Models Available двойным 

щелчком выберите: 

LS-DYNA →  Rigid Material 

Откроется окно Rigid Properties for Material Number 3. 

20. Введите DENS (плотность материала) [К] − 7.85e-9; 

21. Введите EX (модуль Юнга) [Л] − 2e5; 

22. Введите NUXY (коэффициент Пуассона) [М] − 0.3; 

23. В пункте Translation Constraint Parameter выберите X and Y 

disps. [Н] (Разрешаем перемещения по оси Z) (Заметьте! От-

личие от нижней плоскости); 

24. В пункте Rotational Constraint Parameter выберите All rotations 

[O] (Запрещаем все вращения); 

25. Нажмите Ok [П]; 

26. Закройте окно Material – Exit. 

 
 

3.6. Создание модели цилиндрической заготовки 

 

Создадим цилиндрическую модель заготовки: 

 

Ansys main menu → Preprocessor → Modeling → Create → 

Volumes → Cylinder → By Dimensions 

 

Откроется окно Greate Cylinder by Dimensions (рис. 3.13). 

1. Введите RAD1 (внутренний радиус) [А] − 0; 

2. Введите RAD2 (наружный радиус) [Б] − 30; 

3. Введите Z1 (координата по Z1) [В] − 1; 

4. Введите Z1 (координата по Z2) [Г] − 81; 

5. Нажмите Ok [Д]. 
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Рис. 3.13. Определение параметров ци-

линдрической заготовки 

 
На экране должно появиться изображение цилиндра (рис. 3.14) - 

положение цилиндра на экране можно изменить при помощи панели 

видов [Е]. Задайте положение цилиндра как указано на рис. 3.14. 

 

 
 

Рис. 3.14. Вид на экране цилиндрической заготовки 
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3.7. Создание нижней  плоскости 

 

Создадим плоскость в виде квадрата: 

 

Ansys main menu → Preprocessor → Modeling → Create → Are-

as → Rectangle → By Dimensions 

 

Откроется окно Greate Rectangle by Dimensions (рис. 3.15). 

1. Введите X1 [А] − -50; 

 

 
 

Рис. 3.15. Определение параметров плоскости 

 

2. Введите X2 [Б] − 50; 

3. Введите Y1 [В] − -50; 

4. Введите Y2 [Г] − 50; 

5. Нажмите Ok [Д]. 

 
На экране должно появиться изображение плоскости и цилиндра 

(рис. 3.17). Заметьте наличие зазора между цилиндром и плоскостью 

– для предотвращения начального контакта элементов модели. 

 

3.8. Создание верхней плоскости 

 

Верхнюю плоскость получим копированием нижней плоскости в 

направлении Z на 85 мм: 

 

Ansys main menu → Preprocessor → Modeling → Copy → Are-

as 
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Откроется окно Copy Areas (рис. 

3.16). 

1. Левой кнопкой мыши укажи-

те на нижнюю плоскость [А] 

(рис. 3.17); 

2. Нажмите Ok [Б] (рис. 3.16); 

Откроется следующее окно Copy 

Areas (рис. 3.18). 

3. Введите DZ (величину сме-

щения вдоль оси Z) [В] -   

85; 

4. Нажмите Ok [Г]. 

На экране должно появиться 

полное изображение модели, т.е. 

двух плоскостей и цилиндра (рис. 

3.19). 

 

 

 
Рис. 3.16. Копирование 

плоскости 

 
 
Рис. 3.17. Вид на экране цилиндрической заготовки и нижней плоскости 
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Рис. 3.18. Ввод параметра для копирования плоскости 

 

 
 

Рис. 3.19. Вид на экране всей модели 

 
3.9. Сеточное разбиение модели 

 

Разобьем модель на конечные элементы. Цилиндрическую заго-

товку представим объемными конечными элементами, плоскости – 

оболочными конечными элементами: 
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Ansys main menu → Preprocessor → Meshing → MeshToll 

 

 
Откроется окно MeshToll (рис. 

3.20). 

1. В раскрывающимся меню [А] 

выберите Volume; 

2. Нажмите Set [Б]; 

Откроется окно Volume Attributes 

(рис. 3.21). 

3. На экране левой кнопкой 

мыши укажите цилиндриче-

скую заготовку [В] (рис. 

3.22); 

4. Нажмите Ok [Г] (рис. 3.21); 

Откроется окно Volume Attributes 

(рис. 3.23). 

5. Выберите Material number − 1 

[Д]; 

6. Выберите Element type num-

ber – 2 SOLID 164 [Е]; 

7. Нажмите Ok [Ж]; 

8. В третьей части окна 

MeshToll – Size control line 

(рис. 3.20). Нажмите Set [З]; 

На экране левой кнопкой мыши 

поочередно укажите все линии 

принадлежащие объему (цилин-

дрической заготовке) [И] (рис. 

3.24) (всего 10 линий). 

 
 

Рис. 3.20. Сеточное меню 
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Рис. 3.21. Атри-

буты объема 

 
 

Рис. 3.22. Выбор на экране цилиндрической заготовки 

 

 
 

Рис. 3.23. Определение параметров цилиндрической заготовки 
 

9. В окне Element Size on Picked… подтвердите выбранные элемен-

ты кнопкой Ok [К] (3.25); 

Откроется окно Element Sizes on Picked Lines (рис. 3.26). 

10. Укажите параметр NDIV – 10 [Л]; 

11. Нажмите кнопку Ok [M]; 

12. В четвертой части окна MeshToll − Mesh (рис. 3.20) из открыва-

ющегося меню выберите Volume [Н]; 

13. Выберите форму сетки Hex [O]; 
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Рис. 3.24. Выбор линий принадлежащих цилиндру 
 

 

14. Выберите свойства разби-

ения Sweep [П]; 

15. Нажмите кнопку Sweep 

[P]; 

16. На экране левой кнопкой 

мыши укажите цилиндри-

ческую заготовку [В] (рис. 

3.22); 

17. Нажмите кнопку Ok на 

окне Volume Sweeping; 

18. Нажмите на кнопку Close 

[С] на окне MeshToll; 

На экране должно появиться се-

точное разбиение цилиндриче-

ской заготовки (рис. 3.27). 

 
 

Рис. 3.25. Подтверждение выбора 

линий 
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Рис. 3.26. Ввод параметра разделения линий для сеточного разби-

ения 

 

 
 

Рис. 3.27. Сеточное разбиение цилиндра 

 
3.10. Представление модели в исходном виде 

 

Ansys utility menu → Plot → Areas 

 

3.11. Сохранение модели 

 

Ansys utility menu → File → Save as Jobname.db 
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Модель сохранится. Чтобы восстановить данное сохранение (на 

любом последующем шаге) можно использовать следующую 

команду: 
 

Ansys utility menu → File → Resume Jobname.db 
 

3.12. Создание сеточного разбиения плоскостей 
 

Создадим конечно-элементную модель на обеих плоскостях: 

 

Ansys main menu → Preprocessor → Meshing → MeshToll 

 
Откроется окно MeshToll (рис. 3.28). 

1. В раскрывающимся меню [А] выберите 

Areas; 

2. Нажмите Set [Б]; 

Откроется окно Area Attributes (рис. 3.29). 

3. На экране левой кнопкой мыши укажи-

те нижнюю плоскость [В] (рис. 3.30) 

(нижняя плоскость у начала коорди-

нат); 

4. Нажмите Ok [Г] (рис. 3.29); 

Откроется окно Area Attributes (рис. 3.31). 

5. Выберите Material number − 2 [Д]; 

6. Выберите Real constant – 1 [E]; 

7. Выберите Element type number – 1 

SHELL 163 [Ж]; 

8. Нажмите Apply [З]; 

9. Снова откроется окно Area Attributes 

(рис. 3.29); 

10. На экране левой кнопкой мыши ука-

жите верхнюю плоскость [И] (рис. 

3.30); 

11. Нажмите Ok [Г] (рис. 3.29); 

Откроется окно Area Attributes (рис. 3.31). 

 

 
 

Рис. 3.28. Сеточное ме-

ню 
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Рис. 3.29. Под-

тверждение выбора 

плоскостей 

 

 
 

Рис. 3.30. Выбор плоскостей на экране 

 

12. Выберите Material number − 3 [Д] (Заметьте отличие!); 

13. Выберите Real constant – 1 (E); 

14. Выберите Element type number – 1 SHELL 163 [Ж]; 

15. Нажмите Ok [K]; 

16. В третьей части окна MeshToll – Size control line (рис. 3.28) 

нажмите Set [Л]; 

17. На экране левой кнопкой мыши поочередно укажите все линии, 

принадлежащие двум плоскостям [М] (рис. 3.32) (всего 8 ли-

ний); 

18. В окне Element Size on Picked… подтвердите выбранные эле-

менты кнопкой Ok [Н] (3.33); 

Откроется окно Element Sizes on Picked Lines (рис. 3.34). 

19. Укажите параметр NDIV – 5 [О]; 

20. Нажмите кнопку Ok [П]; 

21. В четвертой части окна MeshToll − Mesh (рис. 3.28) из откры-

вающегося меню выберите Areas [Р]; 

22. Выберите форму сетки Quad [С]; 

23. Выберите свойства разбиения Mapped [Т]; 
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24. Нажмите кнопку Mesh [У]; 

25. На экране левой кнопкой мыши укажите обе плоскости [В, И] 

(рис. 3.30); 

26. Нажмите кнопку Ok на окне Mesh Areas [Г] (рис. 3.29); 

27. Нажмите на кнопку Close [Ф] на окне MeshToll (рис. 3.28). 

На экране должно появиться сеточное разбиение 2-х плоскостей и за-

готовки (рис. 3.35). 

 

 
 

Рис. 3.31. Ввод атрибутов плоскостей модели 

 

 
 

  
Рис. 3.32. Выбор линий принадлежащие плоско-

стям 

Рис. 3.33. Подтвер-

ждения выбора линий 
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Рис. 3.34. Ввод параметра разделения линий для сеточного разбиения 

 

 
 

Рис. 3.35. Полная сеточная модель 

 
3.13. Определение частей модели 

 

Определим объекты модели в виде частей (part): 

 

Ansys main menu → Preprocessor → LS-DYNA Options → Parts 

Options 
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Откроется окно Parts Data Written for LS-DYNA (рис. 3.36). 

1. Укажите Create all parts (A); 

2. Нажмите Ok [Б]; 

 

 
 

Рис. 3.36. Создание частей модели 
 

Откроется окно, указывающее просмотр созданных частей. А также 

их атрибуты (рис. 3.37). 

Проверьте ваши результаты с результатами в данном окне. 

3. Закройте окно. 

 

 
 

Рис. 3.37. Выходное окно с параметрами модели 

 
3.14. Определение контакта между частями модели 

 

Зададим контактные определения в модели: 
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Ansys main menu → Preprocessor → LS-DYNA Options → Con-

tact → Define Contact 
 

Откроется окно Contact Parameter Definitions (рис. 3.38). 

1. Выберите тип контакта Contact Type – Surface to Surf [А], 

Automatic [Б]; 

2. Введите Static Friction Coefficient – 0.2 [В]; 

3. Введите Viscous Damping Coefficient – 20 [Г]; 

4. Нажмите Apply [Д]; 

Откроется окно Contact Options (рис. 3.39). 

5. Введите Contact Part no. [E] − 1; 

6. Введите Tanget Part no. [Ж] – 2; 

7. Нажмите Apply [З] ; 

8. В окне (рис. 3.38) нажмите Ok [И]; 

9. Введите Contact Part no. [E] − 1; 

10. Введите Tanget Part no. [Ж] – 3; 

11. Нажмите Ok [K]. 

 

 
 

Рис. 3.38. Определение контактных параметров 
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Рис. 3.39. Определение контактных частей 

 
3.15. Определение параметров массива 

 

Определим параметры массива для задания данных нагрузка-время: 

 

Ansys Utility menu → Parameters → Array Parameters → De-

fine/Edit 

 

Откроется окно Array Parameters (рис. 3.40). 

1. Нажмите кнопку Add [А]; 

Откроется окно Add New Array Parameter (рис. 3.41). 

2. Введите Parameter name – Perem [Б]; 

3. Введите No of rows – 3 [В]; 

4. Нажмите Apply [Г]; 

5. Введите Parameter name – Time [Б]; 

6. Нажмите Ok [Д]; 

Откроется окно Array Parameters (рис. 3.42). 

7. Отметьте в таблице Parameter первую строчку с названием Perem 

[Е]; 
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Рис. 3.40. Создание массива данных 
 

 
 

Рис. 3.41. Создание имени и размерности массива 

 

8. Нажмите кнопку Edit [Ж]; 

Появится окно Array Parameter PEREM (рис. 3.43). 

9. Введите параметры массива 2 − ―- 1000‖ (З); 3 − ―- 1000‖ [И]; 

10. Вверху окна Array Parameter PEREM выберите File → Ap-

ple/quit; 

11. В окне Array Parameters (рис. 3.42) выберите строчку Time [K]; 
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Рис. 3.42. Выбор соответствующего массива для ввода данных 
 

 
 

Рис. 3.43. Ввод данных для первого массива 
 

12. Нажмите кнопку Edit [Ж]. 

13. В окне Array Parameter TIME 

введите параметры массива 2 − 

―0.001‖ [Л]; 3 − ―0.05‖ [М] (рис. 

3.44); 

14. Вверху окна Array Parameter 

PEREM выберите File → Ap-

ple/quit; 

15. Закройте окно Array Parameters 

- нажмите на кнопку Close [П]. 

 
 

Рис. 3.44. Ввод данных для 

второго массива 
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3.16. Создание нагрузки 
 

Определим нагрузку, действующую на верхнюю плоскость в виде 

скорости по оси Z: 

 

Ansys main menu → Solution → Loading Options → Specify 

Loads 
 

Откроется окно Specify Load for LS-DYNA Explicit (рис. 3.45). 

1. Выберите Load option – Add Loads [А]; 

2. Выберите Load Labels – RBVZ [Б]; 

3. Выберите PART number − 3 [В]; 

4. Выберите Parameter name for time values − Time [Г]; 

5. Выберите Parameter name for data values − Perem[Д]; 

6. Нажмите Ok [Е]. 

 

 
 

Рис. 3.45. Определение нагрузок 
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3.17. Определения параметра контроля Hourglass 

 

Определим параметр контроля искажения Hourglass: 

 

Ansys main menu → Solution → Analysis Options → Hourglass 

Ctrls → Local 

 

Откроется окно Define Hourglass Material Properties (рис. 3.46). 

1. Установите параметр Hourglass control type в значение 4 [А]; 

2. Нажмите Ok [Б]. 

 

 
 

Рис. 3.46. Определение параметра Hourglass 

 
3.18. Введение времени окончания анализа 

 

Определим время окончания расчета: 

 

Ansys main menu → Solution → Time Controls → Solution Time 

 

Откроется окно Solution Time for LS-DYNA Explicit (рис. 3.47). 

1. Выберите [TIME] – 0.03 [А]; 

2. Нажмите Ok [Б]. 
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Рис. 3.47. Определение времени завершения процесса 

 

 

3.19. Введение частоты вывода данных 

 

Определим частоту вывода данных: 

 

Ansys main menu → Solution → Output Controls → File Output 

Freq → Number of Steps 

 

Откроется окно Specify File Output Frequency (рис. 3.48). 

1. Выберите [EDRST] – 100 [А]; 

2. Выберите [EDHTIME] – 1000 [Б]; 

3. Нажмите Ok [В]. 

 

 
 

Рис. 3.48. Определение частоты выхода данных 
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3.20. Создание выходных файлов с сохранением данных по уси-

лиям и энергии 

 

Определим дополнительные выходные файлы баз ASCII: 

 

Ansys main menu → Solution → Output Controls → ASCII Out-

put 

 

Откроется окно ASCII OUTPUT (рис. 3.49). 

1. Выберите Material energy [А]; 

2. Выберите Resultant forces [Б]; 

3. Нажмите Ok [В]. 

 

 

 

 
Рис. 3.49. Окно выбора выходных файлов базы ASCII 

 
3.21. Создание К-файла 

 

Определим выходной k-файл для решателя LS-DYNA: 

 

Ansys main menu → Solution → Write Jobname.k 

 

Откроется окно Input files to be Written for LS-DYNA (рис. 3.50). 

1. Выберите Write results files for… – ANSYS and LS-DYNA [А]; 

2. Нажмите Ok [Б]. 
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Рис. 3.50. Создания К-файла 

 
Появится окошко (рис. 3.51) с информацией по k-файлу. 

 

 
 

Рис. 3.51. Сохранение параметров в формате программы LS-Dyna 

 

Закройте это окошко. Сохраните расчетную модель (см. п.3.11). 

 

3.22. Запуск на решение 

 

Запустим процесс решения: 

 

Ansys main menu → Solution → Solve 

 

Появится окошко Solve Current Load Step (рис. 3.52). 

Нажмите Ok [А]. 

 

 
 

Рис. 3.52. Подтверждение запуска процесса на решение 
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* - при появлении предупреждения об ошибке продолжите выполне-

нии процесса (нажмите Yes) 

 

Процесс перейдет к решателю программы LS-Dyna, и появиться 

окошко процесса решения (рис. 3.53). 

 

 
 

Рис. 3.53. Окошко выполнения процесса решения в решателе про-

граммы LS-Dyna 

 

По завершению процесса расчета на экран будет выведено сооб-

щение (рис. 3.54). 

 

 
 

Рис. 3.54. Окно завершения выполнения процесса расчета 
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Выполнение постпроцессорной обработки полученных ре-

зультатов 

 

3.23. Загрузка данных в POST1 для чтения определенного шага 

решения 

 

Для начала прочитаем результаты для определенного шага 

(например, для шага 82 - соответствует осадке заготовки на 20 мм): 

  

Ansys main menu → General Postproc → Read Results → By Pick 

 

Откроется окно Results File (рис. 3.55). 

1. Выберите шаг 82 [А]; 

2. Нажмите Read [Б]; 

3. Нажмите ―Close‖ (B). 

 

 

 
 

Рис. 3.55. Выбор определенного этапа деформирования заготовки 
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3.24. Просмотр контуров деформированной заготовки  

 

Просмотрим контуры деформируемой заготовки по параметру 

von Misses stress: 

 

Ansys main menu → General Postproc → Plot Results → Contour 

Plot → Nodal Solu 

 

Откроется окно Contour Nodal Solution Data (рис. 3.56). 

1. Выберите Nodal Solution → Stress → von Misses stress [А]; 

2. Нажмите Ok [Б]. 

 

 
 

Рис. 3.56. Выбор вывода контуров узловых данных по параметру von Miss-

es stress 

 
3.25. Изменение вида масштаба отображения модели на экране  

 

Изменим представление деформированной заготовки на экране на ис-

тинный вид: 
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Ansys Utility menu → PlotCtrls → Style → Displacement Scaling  

 

Откроется окно Displacement Display Scaling (рис. 3.57): 

1. Выберите 1.0 (true scale) [А]; 

2. Нажмите Ok [Б]. 

 

 
 

Рис. 3.57. Изменение отображение масштаба модели на экране 

 
В результате на экране должна получится следующая картина (рис. 

3.58). 

 
 

Рис. 3.58. Контуры напряжений (von Misses stress) на модели для шага 84 
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3.26. Сохранение полученных графических результатов  

 
Сохраним изображение картинки на экране: 

 

Ansys Utility menu → PlotCtrls → Hard Copy → To File 

 

Откроется окно Graphics Hard Copy (рис. 3.59). 

1. Выберите формат сохраняемого изображения [А]; 

2. Нажмите Ok [Б]. 

 

3.27. Просмотр других контуров на заготовке  

 

В окне Contour Nodal Solution Data можно выбрать любые дру-

гие контуры модели. Например, деформации по осям X, Y, Z. 

 

Просмотрим контуры деформированной заготовки по полной 

деформации вдоль оси Х. 

 

Ansys main menu → General Postproc → Plot Results → Contour 

Plot → Nodal Solu 

 

Откроется окно Contour Nodal Solution Data (рис. 3.60). 

1. Выберите Nodal Solution → Total Mechanical Strain → X-

Component of total mechanical strain [А]; 

2. Нажмите Ok [Б]. 

 

В результате на экране должна получится следующая картина 

(рис. 3.61).  

В ряде случае, например, как в нашем, интересно посмотреть 

деформации по сечению модели. 

 

3.28. Определение рабочей плоскости для сечения модели  

 

Определим установки рабочей плоскости (Workplane). 
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Ansys Utility menu → Workplane → Offset WP by Increments 

 

Откроется окно Offser WP (рис. 3.62). 

1. Нажмите на кнопку поворота системы координат вдоль оси X 

[А] – 3 раза. Каждое нажатие обеспечивает поворот на 30
0
. Та-

ким образом, общий угол разворота будет соответствовать 90
0
; 

2. Нажмите Ok [Б]. 

 
 

  
Рис. 3.59. Со-

хранение 

изображения 

модели 

Рис. 3.60. Выбор вывода контуров узловых данных 

по параметру X-total mechanical strain (полные де-

формации по оси X) 

 

3.29. Установка параметров для сечения модели  
 

Установим необходимые параметры для сечения модели рабочей 

плоскостью: 

 

Ansys Utility menu → PlotCtrls → Style → Hidden Line Options 

 

Откроется окно Hidden Line Options (рис. 3.63). 

1. В Type of Plot выберите опцию Q-Slice Z-buffer [А];  

2. Нажмите Ok [Б]. 
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Рис. 3.61. Контуры деформации по оси X на модели для 

шага 84 

 

Рис. 3.62. 

Установка 

положения 

рабочей 

плоскости 

 

 
 

Рис. 3.63. Установка параметров для сечения модели 
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В результате должно получиться изображение контурных линий 

по сечению модели (рис. 3.64). 

Для отображения контуров по компонентам Y и Z необходимо 

выбрать соответствующие позиции на панели Contour Nodal Solution 

Data. 

 

3.30. Просмотр контуров по сечению заготовки по полным де-

формациям вдоль оси Y  
 

Просмотрим деформации по сечению заготовки вдоль оси Y: 

 

Ansys main menu → General Postproc → Plot Results → Contour 

Plot → Nodal Solu 

 

Откроется окно Contour Nodal Solution Data (рис. 3.60). 

1. Выберите Nodal Solution → Total Mechanical Strain → Y-

Component of total mechanical strain [В]; 

2. Нажмите Ok [Б]. 

Должно получиться изображение контурных линий по сечению моде-

ли (рис. 3.65). 

 

3.31. Просмотр контуров по сечению заготовки по полным де-

формациям вдоль оси Z  

 

Просмотрим деформации по сечению заготовки по деформациям 

вдоль оси Z. 

 

Ansys main menu → General Postproc → Plot Results → Contour 

Plot → Nodal Solu 

 

Откроется окно Contour Nodal Solution Data (рис. 3.60). 

1. Выберите Nodal Solution → Total Mechanical Strain → Z-

Component of total mechanical strain [Г]; 
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2. Нажмите Ok [Б]. 

Должно получиться изображение контурных линий по сечению 

модели (рис. 3.66). 

 

 
 

Рис. 3.64. Контуры деформации по компоненте X по сече-

нию модели для шага 84 

 
 

Рис. 3.65. Контуры деформации по компоненте Y по се-

чению модели для шага 84 
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Рис. 3.66. Контуры деформации по компоненте Z по се-

чению модели для шага 84 

 

3.32.Загрузка данных в POST26 для построения графиков в зави-

симости от времени  

 

Кроме построения контур диаграмм для конкретного этапа рас-

чета постпроцессор Ansys позволяет выводить графики зависимостей 

различных параметров от времени. Для этого используется Постпро-

цессор временной истории (POST26 – TimeHist Postproc). 

 

Загрузим данные в POST26: 

 

Ansys main menu → TimeHist Postproc 

 

Откроется окно Time History Variables (рис. 3.67). 

1. Нажмите  File → Open Results [А]; 

Появиться окно (рис. 3.68) для выбора сохраненного файла проведен-

ного расчета. 

2. Выберите файл file.his [Б]. Заметьте: расширение файла должно 
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иметь расширение his (файл истории); 

3. Нажмите открыть [В]; 

Появится окно выбора файла исходной базы данных (рис. 3.69). 

4. Выберите файл с расширением *db [Г]; 

5. Нажмите открыть [Д]. 

 

 
 

Рис. 3.67. Окно Time History Variables для построения 

графиков различных значений по времени 

 

 
 

Рис. 3.68. Выбор файла с сохраненными данными временной истории 
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Рис. 3.69. Выбор файла исходной базы данных 

 
3.33. Чтение файла с сохраненными данными по усилиям  

 

Проанализируем усилие, с которым подвижная верхняя плоскость да-

вит на цилиндрическую заготовку при осадке. Для этого прочитаем 

файл с сохраненными данными по усилиям:  

 

Ansys main menu → TimeHist Postproc → Read LSDYNA Data 

→ RCFORC file 
 

Откроется окно Read data from the RCFORC file (рис. 3.70). 

1. Установите параметр Read data for contact number… значение 2 

[А], что соответствует второму контактному определению (кон-

такт заготовки с верхней плоскостью); 

2. Нажмите Ok [Б].  

 

 
 

Рис. 3.70. Окно данных для параметра усилия 
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3.34. Построение графика зависимости усилия от времени  

 

Заново откроем окно Time History Variables*:  

 

Ansys main menu → TimeHist Postproc → Variable Viewer 

 

Откроется окно Time History Variables (рис. 3.71). 

1. Выберем направление действия усилия – Z FORCE [А]; 

2. Нажать на кнопку построения графика [Б]; 

3. Закрыть окно [В]. 

Должен появится график зависимости усилия по оси Z от времени 

(рис. 3.72). Этот график характеризует усилие, с которым подвижная 

верхняя плоскость давит на цилиндрическую заготовку при осадке. 

*- если оно открыто, то его необходимо перед этим закрыть 
 

 
 

Рис. 3.71. Окно Time History Variables с до-

ступным выбором параметров усилия 
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Рис. 3.72. График зависимости усилия по оси Z от времени 

 
3.35. Чтение файла с сохранными данными по энергиям  

 

Проанализируем внутреннюю энергию деформирования заготовки 

при осадке. Для этого прочитаем файл с сохраненными данными по 

энергии:  

 

Ansys main menu → TimeHist Postproc → Read LSDYNA Data 

→ MATSUM file 

 

Откроется окно Read data from the MATSUM file (рис. 3.73). 

1. Установите параметр Read data for part number… значение 1 [А], 

что соответствует 1-ой части (part), которой является заготовка; 

2. Нажмите Ok [Б].  
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Рис. 3.73. Окно данных для параметра энергии 

 

3.36. Построение графика зависимости внутренней энергии от 

времени  

 

Откроем окно Time History Variables: 

 

Ansys main menu → TimeHist Postproc → Variable Viewer 

 

Откроется окно Time History Variables (рис. 3.74). 

1. Выберем внутреннюю энергию деформирования заготовки – 

INTNENE [А]; 

2. Нажать на кнопку построения графика [Б]; 

3. Закрыть окно [В]. 

Должен появится график зависимости внутренней энергии от времени 

(рис. 3.75).  

 

3.37. Сравнение результатов моделирования и теории 

 

Теоретическая оценка усилия деформирования [15]: 


















2

2

2

2

34 H

DD
P K

ST





= 
















603

3,69144
250

4

3,69 2
=1,15 МН. 

Теоретическая оценка работы деформирования: 

4

2

1D
hA ST   = 

4

60
20250

2

  =18,8 МДж. 



 

 104 

 
 

Рис. 3.75. График зависимости усилия по оси Z от времени 

 

 

 
 

Рис. 3.74. Окно Time History Variables с до-

ступным выбором параметров энергии 
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Результаты моделирования для усилия и работы при деформи-

ровании цилиндрической заготовки при ∆h=20 мм (соответствует 

времени 2,42e-2 cек., 84 шаг) равно следующим значениям (рис. 3.76): 

Pмод =1,42 МН;  

Амод =19,8 МДЖ. 
 

  
а б 

 

Рис. 3.76. Определение величины усилия (а) и внутренней энергии (б) 

при ∆h=20 мм (соответствует времени 2,42e-2 cек.) 

 

В таблице 3.1 приведено сравнение результатов теории и моде-

лирования и величины погрешностей 

 

Сравнение результатов теории и моделирования 

 Таблица 3.1. 

 Теория Моделирование Погрешность, % 

Усилие, МН 1,15 1,42 19 

Энергия, МДж 18,8 19,8 5 

 

Различие между результатами теории и моделирования (таблица 

3.1) в первую очередь связаны с допущениями принятыми в теории 

осадки (не учитывается появление бочкообразности, неравномерной 

деформации по сечению образца и др.) и в нашем случае слишком 

крупной сетки. Различие результатов между теорией и практикой в 

пределах (20-25)% в ОМД считается допустимыми. 
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ВОПРОСЫ ДЛЯ САМОПРОВЕРКИ И ПРАКТИЧЕСКИЕ 

ЗАДАНИЯ 

 

1. От чего зависит критический шаг в явном методе анализа? 

2. Запустите программу ANSYS и ответьте на следующие вопро-

сы: 

- как перейти к проведению динамического анализа в программе 

ANSYS/LS-DYNA? 

- для чего предназначены модули меню Ansys Main Menu - Pre-

processor, Solution, General Postproc? 

- для чего предназначены пункты модуля Preprocessor – Element 

Type, Real Constants, Material Props? 

- для чего предназначено меню Ansys Utility Menu?  

3. Как определяется согласованная система единиц измерения в  

ANSYS/LS-DYNA? 

4. Перечислите три основных этапа моделирования? 

5. Перечислите основные отличия элементных формулировок для 

типа элемента Shell 163? 

6. Какие основные параметры характерны для большинства рас-

сматриваемых моделей материала? 

7. Как определяется модуль пластичности для билинейной моде-

ли материала? 

8. С помощью каких пунктов модуля Preprocessor проводят со-

здание геометрической модели и конечно-элементной сетки? 

9. Какие основные действия необходимы для нанесения конечно-

элементной сетки при использовании меню Meshtool? 

10. Что такое часть (Part)? 

11. Как определяется контакт и основные параметры контакта в 

программе ANSYS/LS-DYNA? 

12. Перечислите основные контактные типы и опции контакта в 

программе ANSYS/LS-DYNA? 

13. Как задаются нагрузки в программе ANSYS/LS-DYNA? 
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14. Для чего необходимо определение параметров контроля Hour-

glass? 

15. Укажите отличие постпроцессоров POST1 и POST26? 

16. При выполнении моделирования процесса осадки цилиндри-

ческой заготовки ответьте на следующие вопросы: 

- почему используется два типа элемента – shell и solid? 

- почему используется билинейная модель материала, а не упру-

гая? 

- можно ли было использовать пластическую кинематическую в 

степенном виде модель материала? Какие бы в этом случае по-

требовались параметры моделей материала? Какая модель ма-

териала наиболее близка к реальной модели? 

- как можно было бы еще создать геометрическую модель про-

цесса осадки? 

- почему геометрические модели не должны соприкасаться друг 

с другом? 

- каким параметром (или какими параметрами) сеточного меню 

Meshtool можно было бы уменьшить размер конечных элемен-

тов модели? 

- как представить на экране геометрическую модель в виде то-

чек, линий, плоскостей? 

- перечислите какие части (Part) были созданы в меню опреде-

ления частей? 

- почему данные скорости при определении массива (рис. 3.43) 

вводятся в отрицательных величинах? 

- что означает метка ―RBVZ‖ при определении параметров 

нагрузки? 

- для чего создаются выходные файлы базы ASCII (material en-

ergy, resultant force и др.)? 

- какие параметры можно контролировать при решении задачи в 

выходном окне решения LS-DYNA? 

- какие выходные данные можно получить в основном постпро-

цессоре POST1? 
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- для чего необходимо представление деформированной заго-

товки в истинном виде? 

- какие выходные данные можно получить во временном пост-

процессоре POST26? 

17. Попробуйте изменить входные параметры процесса и обос-

нуйте полученные результаты: 

- характеристики материала T = 350 МПа, В = 700 МПа;  = 

7,85e-9;  = 0,3; 

- задайте полностью интегрированную элементную формули-

ровку (опция Full int S/R, рис. 2.6); 

- уменьшите величину разбиения линий модели в 2 раза; 

- увеличьте величину разбиения линий модели в 2 раза, прокон-

тролируйте получившиеся количество элементов;  

- увеличьте коэффициент трения до 0,5; 

- уменьшите коэффициент трения до нуля; 

- увеличьте исходную скорость движения верхней плоскости в 2 

раза; 

- увеличьте временной шаг в 20 раз, сравните графики внутрен-

ней энергии и усилия. 

18. Попробуйте построить модель процесса со следующими из-

менениями: 

- вместо цилиндра используйте трубную заготовку со стенкой 10 

мм; 

- вместо прямоугольных пластин используйте круглые с радиу-

сом 50 мм; 

- задайте ½  (¼) части исходной геометрии, наложив на плоско-

сти симметрии соответствующие ограничения. 
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ЗАКЛЮЧЕНИЕ 

 

В учебном пособии были изложены основы работы с програм-

мой ANSYS/LS-DYNA с акцентом на моделирование процессов обра-

ботки давлением. Приведены типовые модели материалов, типы эле-

ментов, виды нагружений характерные для задач обработки металлов 

давлением. Приведен подробный пошаговый пример моделирования 

процесса осадки цилиндрической заготовки. 

Работа выполнена в ОАО «Ульяновский НИАТ» и в Ульянов-

ском государственном университете на кафедре проектирования и 

сервиса автомобилей. 

ОАО «Ульяновский НИАТ» - одно из ведущих предприятий 

России, которое на протяжении более 30 лет разрабатывает и произ-

водит профилегибочное оборудование и специализируется на разра-

ботке и внедрении технологий, используя уникальные методы дефор-

мирования листового материала (метод стесненного изгиба, метод ин-

тенсивного деформирования). 

Начиная с 2010 г. на предприятии, при разработке новых техно-

логий формообразования и рубки листового материала, используется 

коммерческая версия программы LS-DYNA. В программе LS-DYNA 

были проанализированы и оптимизированы несколько десятков тех-

нологических схем формообразования и рубки гнутых профилей. 

Кроме того, в программе проводятся различные научные исследова-

ния по совершенствованию применяемых методов формообразования 

[16]. 

С помощью программы LS-DYNA были разработаны: 

- технологические схемы для изготовления профилей стрингер и 

шпангоут фюзеляжа самолета МС-21; 

- режимы формообразования для изготовления профилей с про-

дольной кривизной для сборных металлических гофрированных кон-

струкций; 
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- процессы редуцирования круглой исходной заготовки в про-

филь сложной формы (профиль для опалубки зданий, профиль син-

хронизатора сидения автомобиля); 

- процессы формообразования и рубки различных профилей для 

строительства и автомобилестроения (всего более 40 технологических 

схем). 

Комплекс программ ANSYS используется также в Ульянов-

ском государственном университете на кафедре проектирования 

и сервиса автомобилей. Основная научная работа кафедры связана с 

исследованиями напряженно-деформированного состояния деталей и 

узлов конструкций автомобилей и других транспортных средств.  

На кафедре комплекс программ ANSYS может использоваться в 

следующих направлениях: 

- анализ прочности и кинематики транспортных средств; 

- расчет и оптимизация отдельных элементов конструкции 

транспортных средств; 

- расчет подвески транспортных средств; 

- анализ повреждений в результате столкновений (краш-анализ), 

оценка безопасности пассажиров; 

- расчет процессов гидродинамики и нестационарной нелиней-

ной динамики; 

- анализ процессов теплопередачи при нагреве. 

 

Все Ваши замечания и пожелания можно отправлять на элек-

тронный адрес автора: fzbm@mail.ru 

 

С наилучшими пожеланиями! 
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